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Translations 
Product documents may be provided in additional languages on electronic media. 

Symbols Lexicon 

 
European Conformity 

 
Manufacturer 

 
Authorized Representative in 

the European Union 

 
Lot Number 

 
Use by 

 
For In Vitro Diagnostic Use 

 
Temperature Limit 

 
Catalog Number 

 
Consult Instructions for Use 

 
Number of Tests 

 
For use with 

 
Serial Number 

 
Prescription Use Only 

 
Unique Device Identification – 

Device Identifier 
 

Contains Latex 

 
Research Use Only 

 
Single Use Only 

 
Biohazard 

 

Bio-Rad Technical Support  
The Bio-Rad Technical Support department in the U.S. is open Monday through Friday, 5:00 AM to 5:00 
PM, Pacific Time. 

Phone: 1-800-424-6723, option 2 

Email: Support@Bio-Rad.com (U.S./Canada only) 

For technical assistance outside the U.S. and Canada, contact your local technical support office or click the 
Contact Us link at bio-rad.com. 
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Legal Notices  
No part of this publication may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, including photocopy, recording, or any information storage or retrieval system, without 
permission in writing from Bio-Rad Laboratories.  

Bio-Rad reserves the right to modify its products and services at any time. This instruction manual is subject  
to change without notice. Although prepared to ensure accuracy, Bio-Rad assumes no liability for errors or 
for any damages resulting from the application or use of this information.  

BIO-RAD, DDPCR, DROPLET DIGITAL PCR, HARD-SHELL, and MICROSEAL are trademarks of Bio-Rad 
Laboratories, Inc. in certain jurisdictions. 

Hard-Shell Plates are covered by one or more of the following U.S. patents or their foreign counterparts 
owned by Eppendorf AG: U.S. Patent Numbers 7,347,977; 6,340,589; and 6,528,302. 

All trademarks used herein are the property of their respective owner. 

This product and/or its use is covered by claims of U.S. patents, and/or pending U.S. and non-U.S. patent 
applications owned by or under license to Bio-Rad Laboratories, Inc. Purchase of the product includes a 
limited, non-transferable right under such intellectual property for use of the product for internal research 
and diagnostic purposes only. For the purposes of SARS-CoV-2, influenza A, and influenza B testing, Bio-
Rad grants the rights for use of the product for commercial applications of any kind, including but not 
limited to manufacturing, quality control, or commercial services, such as contract services or fee for 
services. Information concerning a license for such uses can be obtained from Bio-Rad Laboratories. For 
any purpose beyond SARS-CoV-2, influenza A, and influenza B testing, it is the responsibility of the 
purchaser/end-user to acquire any additional intellectual property rights that may be required.  

Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit 
Warnings and Precautions 
For in vitro diagnostic use under Emergency Use Authorization.  For healthcare professional use. 

This test kit should be handled only by qualified personnel trained in laboratory procedures and familiar 
with their potential hazards. Wear appropriate protective clothing, gloves, and eye/face protection and 
handle appropriately with the requisite Good Laboratory Practices. 

Personal Protective Equipment (PPE) 
Proper use of gloves is recommended with the use of components and sample plates. OSHA requirements 
for PPE are set forth in the Code of Federal Regulations (CFR) at 29 CFR 1910.132 (General requirements); 
29 CFR 1910.138 (Hand protection); 29 CFR 1926.95 (Criteria for standard personal protective equipment). 
Any gloves with impaired protective ability should be discarded and replaced. 
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Intended Use  
The Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit is a real-time reverse transcription 
polymerase chain reaction (RT-PCR) test intended for the simultaneous qualitative detection and 
differentiation of nucleic acid from SARS-CoV-2, influenza A, and/or influenza B in nasopharyngeal swabs 
and anterior nasal swabs, collected from individuals suspected of respiratory viral infection consistent with 
COVID-19 by their healthcare provider. Clinical signs and symptoms of respiratory viral infection due to 
SARS-CoV-2 and influenza can be similar.  

Testing is limited to laboratories certified under the Clinical Laboratory Improvement Amendments of 1988 
(CLIA), 42 U.S.C. §263a, that meet requirements to perform high complexity tests.     

The Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit is intended for use in the simultaneous 
detection and differentiation of SARS-CoV-2, influenza A, and/or influenza B viral RNA in clinical specimens,  
and is not intended to detect influenza C. RNA from influenza A, influenza B, and/or SARS-CoV-2 viruses is 
generally detectable in upper respiratory specimens during the acute phase of infection. Positive results 
are indicative of active infection but do not rule out bacterial infection or coinfection with other pathogens 
not detected by the test; clinical correlation with patient history and other diagnostic information is 
necessary to determine patient infection status. The agent detected may not be the definite cause of 
disease. Laboratories within the United States and its territories are required to report all SARS-CoV-2 
results to the appropriate public health authorities.    

Negative Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit results do not preclude SARS-CoV-2, 
influenza A, and/or influenza B infection and should not be used as the sole basis for diagnosis, treatment, 
or other patient management decisions. Negative results must be combined with clinical observations,  
patient history, and/or epidemiological information.     

Testing with the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit is intended for use by qualified 
laboratory personnel specifically instructed and trained in the techniques of real-time PCR and in vitro 
diagnostic procedures.   

The Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit is only for use under the Food and Drug 
Administration’s Emergency Use Authorization.  

Summary and Principle 
An outbreak of pneumonia caused by a novel coronavirus (SARS-CoV-2) in Wuhan City, Hubei Province, 
China, was identified and reported to the World Health Organization (WHO) on December 31, 2019. The 
rapid spread of SARS-CoV-2 to numerous areas throughout the world necessitates preparedness and 
response in healthcare and laboratory facilities. The availability of specific and sensitive assays for detecting 
the virus is essential for accurate diagnosis of cases, assessing the extent of the outbreak, monitoring of 
intervention strategies, and surveillance studies.  

The Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit is a molecular in vitro diagnostic test 
containing the reagents required to perform an RT-PCR test. The primer and probe sets are designed to 
detect and differentiate SARS-CoV-2, influenza A, and/or influenza B viral RNA in nasopharyngeal swabs 
and anterior nasal swabs, collected from individuals suspected of having respiratory viral infection 
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consistent with COVID-19 by their healthcare provider. Additional testing and confirmation procedures 
should be performed in consultation with public health and/or other authorities to whom reporting is 
required. Test results should be reported in accordance with local, state, and federal 
regulations.  Performance is unknown in asymptomatic patients. 

The oligonucleotide primers and probes for detection and differentiation of SARS-CoV-2, influenza A, 
and/or influenza B viral RNA are the same as those reported by the Center for Disease Control and 
Prevention (CDC) and contain three primer/probe sets (FluA, FluB, and SC2) that target the RNA of influenza 
A virus, influenza B virus, and SARS-CoV-2 virus, respectively.  The assay also contains primers and a probe 
to detect the human RNase P gene (RP) in clinical specimens or control samples.  The oligonucleotide 
primers and probe for detection of SARS-CoV-2 were selected from an evolutionarily conserved region of 
the 3’ terminus of the SARS-CoV-2 genome and include part of the carboxy-terminal portion of the 
nucleocapsid (N) gene. Primers and probes for the detection of influenza A viruses were selected from an 
evolutionarily well-conserved region of the matrix (M1) gene. The primers and probe selected for the 
detection of influenza B viruses were selected from a conserved region of the nonstructural 2 (NS2) gene. 
The assay is a multiplex assay, run in a single well/vessel, designed to detect and differentiate RNA from 
SARS-CoV-2 virus, influenza A viruses, and influenza B viruses. An additional primer/probe set to detect the 
human RNase P (RP) gene in control samples and clinical specimens is also included in the panel. To perform 
a test, RNA is isolated and purified from control samples and clinical specimens then added to a master 
mix made using Bio-Rad Reliance One-Step Multiplex RT-qPCR Supermix.  The master mix includes a reverse 
transcriptase that transcribes RNA into cDNA and a DNA polymerase that amplifies the cDNA fragments 
that share homology with the primer/probe sets. Amplification of specific targets is monitored by the 
change in fluorescence intensity within specific excitation/emission wavelengths using a real-time PCR 
instrument.   

The Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit can be used with the Bio-Rad CFX Opus 96, 
CFX96 Touch, CFX96 Dx, and the Thermo Fisher Scientific, Inc. Applied Biosystems (AB) 7500 Fast Dx Real-
Time PCR Systems (Table 1).  

Table 1. Instruments Required 
Catalog Number Product Name 

12011319 CFX Opus 96 Real-Time PCR System* 
1855195 CFX96 Touch Real-Time PCR Detection System* 

1845097-IVD 
1841000-IVD 

CFX96 Dx ORM 
C1000 Dx Thermal Cycler 

4406985 or 4406984 Applied Biosystems 7500 Fast Dx Real‑Time PCR System 
*Starter packages available  

The CFX96 Touch and CFX Opus 96 Real-Time PCR Detection Systems utilize the CFX Maestro Software 
version 2.0.  The CFX96 Dx utilizes the CFX Manager Dx Software version 3.1.  The Applied Biosystems 7500 
Fast Dx Real-Time PCR Instrument utilizes software SDS version 1.4. 

To mitigate cybersecurity risks, an environment in which access to the real-time instrument and computer 
are controlled by the persons who are responsible for the content of electronic records is essential.  Bio-
Rad requires the following security control to be applied to mitigate risk: 

• Store the real-time instrument and computer in a secure location 
• Enable Window’s Firewall 
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• Enable AppLocker to prevent non-administrator users from running foreign software applications 
or scripts 

• Enable Windows Virus & Threat Protection 
• Enable user passwords to access the CFX Maestro and CFX Manager Dx 
• Enable password-protected screensaver 
• Disable unused ports, both inbound and outbound 
• Disable Remote Services 
• Disable Auto-run for the application 
• Do not set Windows to log in to an Administrator account by default 
• Install Windows Security Updates promptly 
• Do not connect the computer to a network through either ethernet or WiFi (recommended)  

 

Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit 
Workflow 
The workflow consists of four steps (Table 2). 
 
Table 2. Bio-Rad SARS-CoV-2/FluA/FluB RT-PCR Assay Kit Workflow  

Workflow 

Step 1 Isolation of viral RNA from  nasal and mid-turbinate swab specimens as well as nasopharyngeal 
wash/aspirate and nasal aspirate specimen swabs 

Step 2 RT-PCR Plate Setup 
Step 3 One-step reverse transcription and qPCR 
Step 4 Analysis 

 

Reagents and Instruments 

Materials Provided 
The Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit contains sufficient reagents to process a total of 
200 reactions (Table 3). 

Table 3. Materials Included in the Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit 

Product Name QTY 
(Tubes) 

Volume 
(μL) 

Storage 
Conditions, °C 

Reliance One-Step Multiplex Supermix 1 1000 -20°C  
Exact Diagnostics SARS-CoV-2, Flu, RSV Positive Run Control* 1 1000 -20°C 

Exact Diagnostics SARS-CoV-2, Flu, RSV Negative Run Control* 1 1000 -20°C 
SARS-CoV-2/FluA/FluB Oligos 1 300 -20°C 

*The Reliance SARS-CoV-2/FluA/FluB RT-PCR Kit does not detect RSV and no results for RSV will be displayed when 
using the Positive and Negative Controls 

Note: Safety Data Sheets (SDS) are available at bio-rad.com  

http://bio-rad.com/
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Materials Required but Not Provided 
Reagents and Consumables: 

Reagents for RNA Purification 

The QIAGEN QIAamp Viral Mini Kit (Catalog #52906, #52904) is validated for use with the Reliance SARS-
CoV-2/FluA/FluB RT-PCR Assay Kit per the manufacturer’s instructions.  

Generic Reagents and Consumables for Real-Time PCR 
Materials required but not provided for running the Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit on 
the Bio-Rad and Thermo Fisher Scientific Real-Time PCR Systems are listed in Table 4 and Table 5. 
 
Table 4. Materials Required but Not Provided for Running on the CFX Opus 96, CFX96 Touch, and CFX96 
Dx Real-Time Systems 

Bio-Rad 
Catalog # Name QTY 

(each) 
Storage 

Conditions 
MSB1001 Microseal 'B' PCR Plate Sealing Film, adhesive, optical 100 15°C to 30°C 

HSP9955 or 
equivalent* 

HSP9955, Hard-Shell 96-Well PCR Plates, low profile, thin wall, 
skirted, white/white 50 15°C to 30°C 

* Refer to Bio-Rad’s Hard-Shell PCR Plate Brochure 5496 for other 96-well colored shell/white well PCR plates 
 
Table 5. Materials Required but Not Provided for Running on the Applied Biosystems 7500 Fast Dx Real-
Time PCR System 

Thermo Fisher 
Scientific Catalog # Product Name QTY 

(each) 
Storage 

Conditions 
4311971 MicroAmp Optical Adhesive Film 100 15°C to 30°C 

4346906 MicroAmp Fast Optical 96-Well Reaction Plate with 
Barcode, 0.1 mL 20 15°C to 30°C 

 

Instrumentation, Software, and General Laboratory Equipment: 

General laboratory equipment required but not provided for running the Bio-Rad Reliance SARS-CoV-
2/FluA/FluB RT-PCR Assay Kit is listed in Table 6. 

Table 6. General Laboratory Equipment Required but Not Provided 
Description Source 

Single and multichannel adjustable pipettors (1.00 μL to 1,000.0 μL)  Rainin or Eppendorf 
Microcentrifuge Multiple suppliers 
Microwell plate centrifuge, with a rotor that accommodates standard 
microplates Multiple suppliers 

Laboratory mixer, vortex, or equivalent Multiple suppliers 
Laboratory freezers  
• –30°C to –10°C  
• ≤ –70°C  

Multiple suppliers 

96‑well cold block or ice Multiple suppliers 
Nonstick, RNase-free microcentrifuge tubes (1.5 mL and 2.0 mL)  Multiple suppliers 
Sterile aerosol barrier (fi ltered) pipette tips Multiple suppliers 
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General Precautions and Warnings 
1. For In vitro Diagnostic (IVD) Use under Emergency Use Authorization only. 
2. For Prescription (Rx) Use only 
3. For professional use only. 
4. This product has not been FDA cleared or approved, but has been authorized for emergency use 

by FDA under an EUA for use in laboratories certified under the Clinical Laboratory Improvement 
Amendments of 1988 (CLIA), 42 U.S.C.§263a, that meet requirements to perform high complexity 
tests; 

5. This product has been authorized only for the simultaneous qualitative detection and 
differentiation of nucleic acids from SARS-CoV-2, influenza A virus, and influenza B virus, and  not 
for any other viruses or pathogens; and, 

6. The emergency use of this product is only authorized for the duration of the declaration that 
circumstances exist justifying the authorization of emergency use of in vitro diagnostics for 
detection and/or diagnosis of COVID-19 under Section 564(b)(1) of the Federal Food, Drug and 
Cosmetic Act, 21 U.S.C. § 360bbb-3(b)(1), unless the declaration is terminated or authorization is 
revoked sooner. 

7. All biological specimens should be treated as if they are capable of transmitting infectious agents. 
Use safe laboratory procedures, such as those outlined in HHS Publication (CDC) 21-1112, Biosafety 
in Microbiological and Biomedical Laboratories, and in CLSI Document M29-A4, Protection of 
Laboratory Workers from Infectious Disease Transmitted by Blood, Body Fluids, and Tissue. [1, 2] 

8. Specimens should be collected using appropriate infection control precautions if infection with 
SARS-CoV-2 is suspected based on current clinical and epidemiological screening criteria 
recommended by public health authorities.  If infection with a novel influenza A virus is suspected 
based on current clinical and epidemiological screening criteria recommended by public health 
authorities, for novel virulent influenza viruses and sent to state health departments for testing.  

9. Positive SC2 results are indicative of the presence of SARS-CoV-2 RNA.  Laboratories within the 
United States and its territories should report all SARS-CoV-2 test results to the appropriate public 
health authorities, as required.  

10. Thoroughly clean and disinfect all work surfaces with a freshly prepared solution of 0.5% sodium 
hypochlorite (10% bleach) in deionized or distilled water, followed by 70% alcohol.  CAUTION: Lysis 
buffers used with the QIAamp extraction methods contain guanidinium thiocyanate or guanidine 
containing materials. Highly reactive and/or toxic compounds may form if combined with sodium 
hypochlorite (bleach). 

11. To minimize nucleic acid contamination, routinely decontaminate bench space, pipettors, and 
equipment, and separate the specimen and RNA/DNA handling area from the assay preparation 
area. 

12. Optimize workflow and space to minimize the risk of carryover contamination from completed PCR 
reactions. 

13. Ensure that the real-time PCR system and automation system have a dedicated space in separate 
areas to avoid amplicon contamination. 

14. Perform assay setup and template addition in different locations with dedicated pipettors. 
15. Use proper laboratory safety procedures for working with chemicals and handling specimens. 
16. Change gloves frequently when transporting and working with different reagents. 
17. Failure to follow the procedures and conditions described in this document can cause incorrect 

results and adverse effects.  
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18. Do not substitute Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit reagents with other 
reagents. 

19. Setup and template addition must be performed under RNase/DNase-free conditions. 
20. Ensure that regular maintenance and calibration are performed on all equipment according to the 

manufacturer’s recommendations.  
21. Use nuclease-free tips and reagents, and routinely clean pipettors.  
22. Ensure that only the recommended thermal cycling protocol is used.  
23. Do not use diethylpyrocarbonate (DEPC) treated water for PCR amplification. 
24. Closely follow the procedures and guidelines provided to ensure that the test is performed 

correctly. Any deviation from the procedures and guidelines may affect optimal test performance.  
25. False-positive results may occur if the carryover of samples is not adequately controlled during 

sample handling and processing. 
26. Individuals who received nasally administered influenza A/B vaccine may have positive influenza 

test results for up to three days after vaccination. 
http://www.cdc.gov/mmwr/preview/mmwrhtml/rr57e717a1.htm 

Specimen Collection, Handling, and Storage 
Adequate, appropriate specimen collection, storage, and transport are important to obtain sensitive and 
accurate test results. Training in correct specimen collection procedures is highly recommended to ensure 
good quality specimens and results. CLSI MM13-Ed2 may be referenced as an appropriate resource. 

1. Sample acceptance criteria 
● Samples should be collected into sterile, labeled tubes and shipped per testing laboratory 

requirements. 
2. Specimen rejection criteria 

● Samples that have not been pre-approved for testing and those that are labeled improperly 
will not be tested until the required information is obtained. 

3. Collecting the specimen 
● Refer Interim Guidelines for Collecting, Handling, and Testing Clinical Specimens from 

Persons for Coronavirus Disease 2019 (COVID-19). https://www.cdc.gov/coronavirus/2019-
nCoV/guidelines-clinical-specimens.html  

● Follow manufacturer instructions for proper use of specimen collection devices. 
● Swab specimens should be collected using only swabs with a synthetic tip, such as nylon or 

Dacron®, and an aluminum or plastic shaft. Calcium alginate swabs are unacceptable, and 
cotton swabs with wooden shafts are not recommended. Place swabs immediately into sterile 
tubes containing 2-3 mL of viral transport media or universal transport media. 

4. Transporting specimens  
● Specimens must be packaged, shipped, and transported according to the current edition of the 

International Air Transport Association (IATA) Dangerous Goods Regulation. Follow shipping 
regulations for UN 3373 Biological Substance, Category B when sending potential 2019-nCoV 
specimens to the testing laboratory. 

● Store specimens at 2-8°C and ship overnight to the testing laboratory on an ice pack. If a 
specimen is frozen at -70°C or lower, ship overnight to the testing laboratory on dry ice. 

5. Storing specimens  
● Specimens can be stored at 2-8°C for up to 72 hours after collection if necessary. 

http://www.cdc.gov/mmwr/preview/mmwrhtml/rr57e717a1.htm
https://www.cdc.gov/coronavirus/2019-nCoV/guidelines-clinical-specimens.html
https://www.cdc.gov/coronavirus/2019-nCoV/guidelines-clinical-specimens.html
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● If a delay in extraction is expected, store specimens at -70°C or lower until processing can 
commence. 

● Extracted nucleic acid should be stored at 4°C if it is to be used within 4 hours, or -70°C or 
lower if material must be stored longer than 4 hours. 

Use of Control Materials 
Controls to be used with the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit: 

● A no-template control (NTC) is needed to detect reagent and/or environmental contamination.  
This control uses RNase/DNase-free water in place of a clinical specimen sample and should be 
present in a minimum of one well per reaction plate.  

● A positive control is needed to detect substantial reverse transcription and/or reagent failure, 
including primer and probe integrity. The test utilizes Exact Diagnostics SARS-CoV-2, Flu, RSV 
Positive Run Control, which is manufactured with whole inactivated influenza A, influenza B, RSV, 
and SARS-CoV-2 viruses.  One positive control must be included per batch of samples extracted, 
with a minimum of one positive control well per reaction plate. The Reliance SARS-CoV-2/FluA/FluB 
assay does not detect RSV and no result is obtained for this analyte with the Positive Control. 

● A negative control is needed to detect extraction step failure or reagent/environmental 
contamination. The test utilizes Exact Diagnostics SARS-CoV-2, Flu, RSV Negative Run Control, 
which is manufactured with human genomic DNA and RNA. One negative control must be included 
per batch of samples extracted, with a minimum of one negative control well per reaction plate. 
The Reliance SARS-CoV-2/FluA/FluB assay does not detect RSV and no result is obtained for this 
analyte with the Negative Control. 

Reagent Handling and Storage 

Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit  
● The kit contains RT-PCR supermix, assay oligos, positive and negative controls 
● Storage at -20°C is recommended, with minimum freeze-thaw cycles 

Work Areas 
All necessary safety precautions should be taken according to the laboratory guidelines. Precautions 
must also be taken to prevent cross-contamination of samples.  
 
Separate work areas should be used for:  

● Nucleic acid extraction  
● Reagent preparation (for example, preparation of master mix)  

o No amplified reactions, target solutions, or clinical specimens should be brought into 
the reagent preparation area. After working in this area, laboratory coat and gloves 
should be changed before moving into the nucleic acid addition area  

● Nucleic acid addition  
● Instrumentation (for example, thermocyclers)  
 



Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit 

 
10000135012, Rev. A – Instructions for Use  13 

General Handling 
Proper microbiological, aseptic technique should always be used when working with RNA. Hands and 
dust particles may carry bacteria and molds and are the most common sources of RNase 
contamination. Always wear powder-free latex, vinyl, or nitrile gloves while handling reagents, tubes, 
and RNA samples to prevent RNase contamination from the surface of the skin or laboratory 
equipment. Change gloves frequently and keep tubes closed. During the procedure, work quickly and 
keep everything on cold blocks to avoid degradation of RNA by endogenous or residual RNases. Clean 
working surfaces, pipettes, etc., with 10% bleach or other solutions that can destroy nucleic acids and 
RNases. To eliminate accelerated deterioration of any plastics and metals, wipe down with 70% ethanol 
after using 10% bleach. Ensure all bleach is removed to eliminate possible chemical reactions between 
bleach and guanidine thiocyanate, which is present in the extraction reagents. 

Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit 
Protocol 

Overview 
The Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit is a real-time reverse transcription 
polymerase chain reaction (RT-PCR) test intended for the simultaneous qualitative detection and 
differentiation of SARS-CoV-2, influenza A, and/or influenza B viral RNA in nasopharyngeal swabs and 
anterior nasal swabs, collected from individuals suspected of having respiratory viral infection consistent 
with COVID-19 by a healthcare provider.  The assay contains primer/probe sets (FluA, FluB, and SC2) 
targeting viral RNA of influenza A, influenza B, and SARS-CoV-2.  An additional human gene, Human RNase 
P (RP), is included in the assay as an internal control.  Detection of viral RNA aids in the diagnosis of illness 
and provides epidemiological and surveillance information.  

The test comprises two main steps: (1) extraction of RNA from patient specimens and (2) one-step reverse 
transcription and polymerase chain reaction amplification and detection of the targets. 

Description of Test Steps 
Nucleic acids are isolated and purified from nasopharyngeal swabs and anterior nasal swabs using the 
QIAGEN QIAamp Viral RNA Mini Kit, following the manufacturer’s instructions. The purified nucleic acids 
are reverse transcribed then amplified using Reliance One-Step Multiplex RT-qPCR Supermix into cDNA in 
a real-time PCR instrument (Table 1).  The thermocycling protocol used on all instruments is 50.0°C for 10 
min, 95.0°C for 10 min, and 45 cycles of (95.0°C for 10 sec, 60.0°C for 30 sec, plate read). The Reliance One-
Step Multiplex RT-qPCR Supermix contains the reverse transcriptase enzyme and thermostable DNA 
polymerase that supports cDNA synthesis and probe-based qPCR in one tube. The SARS-CoV-2/FluA/Flu/B 
Oligos contain the primers and probes for SARS-CoV-2, influenza A, and influenza B targets, as well as the 
human RP gene for multiplex qPCR.  In the process, the probe anneals to a specific target sequence located 
between the forward and reverse primers.  During the PCR cycle extension phase, the 5’ nuclease activity 
of Taq polymerase degrades the probe, causing the reporter dye to separate from the quencher dye, 
generating a fluorescent signal.  Additional reporter dye molecules are cleaved from their respective 
probes with each cycle, increasing the fluorescence intensity.  Fluorescence intensity is monitored at each 
PCR cycle by real-time PCR instruments. 
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Nucleic Acid Extraction 
Performance of the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit depends on the amount and 
quality of template RNA purified from human specimens.  The QIAGEN QIAamp Viral RNA Mini Kit (Catalog 
#52906, #52904) extraction kit has been qualified and validated for recovery and purity of RNA for use with 
the test. 

 
Follow the manufacturer’s recommended procedures for sample extraction. Positive and negative controls 
must be included in each extraction batch. 

 

Preparation of controls 

Positive control: Extract 140 μL of Exact Diagnostics SARS-CoV-2, Flu, RSV Positive Run Control using 
QIAGEN QIAamp Viral RNA Mini Kit together with patient samples according to the manufacturer’s 
instructions. 

Negative control: Extract 140 μL of Exact Diagnostics SARS-CoV-2, Flu, RSV Negative Run Control using 
QIAGEN QIAamp Viral RNA Mini Kit together with patient samples according to the manufacturer’s 
instructions.  

Preparation of One-Step RT-PCR Reaction 
1. Ensure extracted RNA sample(s) are thawed on ice. 

Note:  Do not vortex RNA samples. RNA samples may be mixed by flicking the tubes, followed by brief 
centrifugation to collect the contents to the bottom of the tubes.  

2. Thaw all kit components on ice. 
3. Mix thoroughly by vortexing each tube briefly to ensure homogeneity, then pulse centrifuge to collect 

contents at the bottom of each tube. 
 Note:  The Reliance One-Step Multiplex RT-qPCR Supermix is viscous and will not freeze at -20°C.  

Some gelling and precipitation may occur; this is expected and does not impact the 
reagent's stability or performance. It is important to thoroughly vortex the reagent before 
beginning the master mix preparation.  

4. RT-PCR master mix preparation: 
a. Prepare a master mix volume sufficient for the number of patient samples and controls to be tested 

plus 10% more volume (Table 7) when more than 1 sample is being tested. 
b. Vortex the master mix briefly and pulse centrifuge to collect the contents to the bottom of the 

tube. 
 
Table 7. RT-PCR Master Mix Component Volumes 

Component Volume for 1 
Sample (μL) 

Volume for 96 
Samples (μL) 

Volume for N 
Samples (μL) 

Reliance One-Step Multiplex RT-qPCR Supermix 5.0  528  (5.0 x N) x 1.1  
SARS-CoV-2/FluA/FluB Oligos 1.5  158  (1.5 x N) x 1.1 

RNase/DNase free water 3.5  370   (3.5 x N) x 1.1 
Volume per reaction 10.0  1056  (10.0 x N) x 1.1 

 
5. Dispense 10 μL of the master mix into the appropriate wells of the RT-PCR plate.  
6. Add 10 μL of RNase/DNase free water to one well for an NTC. 
7. Add 10 μL of negative control material to one well for a Negative Control. 
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8. Add 10 μL of positive control material to one well for a Positive Control. 
9. For the remaining wells, add 10 µL of extracted RNA sample per well. 
10. Seal the plate with an optical sealing film.  
11. Vortex the plate for 30 seconds at high speed. 
12. Centrifuge the RT-PCR reaction plate for 30 seconds at 1000 RCF to remove any air bubbles and allow 

the RT-PCR reaction to settle to the bottom of the wells. If bubbles remain, spin the plate again.   
13. Proceed with loading the RT-PCR reaction plate onto a Bio-Rad CFX Opus 96, CFX96 Touch, CFX96 Dx 

Real-Time PCR Detection System, or an Applied Biosystems 7500 Fast Dx Real-Time PCR instrument. 

Bio-Rad CFX Instrument Setup  
The following instructions are for running SARS-CoV-2/FluA/FluB RT-PCR Assay Kit on a Bio-Rad CFX Opus 
96, CFX96 Touch, or CFX96 Dx Real-Time PCR Detection System.  For more detailed information, refer to 
the instrument manual.  

Using Bio-Rad CFX instrument software, there are three stages for an RT-PCR run: 
1. Protocol Setup 
2. Plate Setup 
3. Running the RT-PCR reaction 

 
Cycling Protocol Setup  
 

1. Click File -> New -> Protocol in the menu bar to open the Protocol Editor 
2. Change Sample Volume to 20 μl  
3. Modify the Cycling Protocol to the guidelines in Table 8 

  
Table 8. Thermal Cycling Protocol 

Step Number Cycling Step Temperature 
(°C) Time Cycles 

1 Reverse transcription 50 10 minutes 1 
2 Enzyme activation 95 10 minutes 1 
3 Denaturation 95 10 seconds 

45 4 Annealing/extension/ plate read 60 30 seconds 
5  Go to step 3 and repeat 44 times -- -- 

 
4. Confirm step 4 includes a plate read, as is indicated by a camera symbol in the step  
5. To add a plate read to step 4, click on the step to highlight, then click Add Plate Read to Step  

 

https://www.bio-rad.com/en-us/sku/msb1001-microseal-b-pcr-plate-sealing-film-adhesive-optical?ID=MSB1001
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Figure 1: Thermal Cycling Protocol 

 
6. Save the protocol by clicking File -> Save As  
7. Name the protocol file “Bio-Rad SARS-CoV-2_FluA_FluB RT-PCR Protocol” 

 

Plate Setup  

1. Click File -> New -> New Plate in the menu bar to open the Plate Editor  
2. Select Settings -> Plate Size -> select 96 wells  
3. Select Settings -> Plate Type -> select BR White 
4. Expand the pull-down menu to the right of Scan Mode and select All Channels 
5. Highlight the wells where samples and controls will be on the plate.  To highlight all wells, click 

the upper left corner of the plate graphic. 
6. Click Select Fluorophores and select FAM, HEX, Texas Red, and Cy5 by checking the Selected box 

to the right of the fluorophore (uncheck SYBR).  Click OK to apply changes. 
7. Define sample type for each well by highlighting the wells then choose the appropriate identifier 

from the Sample Type pull-down menu Wells -> assign Sample Type 
8. Apply target names and fluorophores to all wells by highlighting the wells then checking the 

Load box to the left of each of the fluorophores listed in the Target Name section.  To include the 
target name, replace <none> in the open text box to the right of the fluorophore with the 
following: 

FAM – SARS-CoV-2 
HEX – Influenza A 
Texas Red – RNase P 
Cy5 – Influenza B 

9. Save the file by clicking File -> Save As  
10. Name the plate file “Bio-Rad SARS-CoV-2_FluA_FluB RT-PCR Plate Setup” 
11. Close the file by clicking File -> Close 

Running the RT-PCR Plate on CFX Real-Time PCR Systems 
1. Select the instrument from the Select Instrument drop-down menu in the Startup Wizard 
2. Click User-defined in the Select run type section of the Startup Wizard.  This will open the Run 

Setup panel. 
3. Click Select Existing in the protocol tab 
4. Select the cycling protocol file “Bio-Rad SARS-CoV-2_FluA_FluB RT-PCR Protocol.prcl” 
5. Click Open to apply 
6. Confirm the cycling protocol is as shown in Table 8 
7. Click the Plate tab in the Run Setup panel 
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8. Click Select Existing 
9. Select the plate setup file “Bio-Rad SARS-CoV-2_FluA_FluB RT-PCR Plate Setup.pltd” 
10. Click Open to apply 
11. Click the Start Run tab in the Run Setup panel 
12. Select the instrument in the Start Run on Selected Blocks section by checking the box to the left 

of the instrument name  
13. Load the plate into the instrument 
14. Click Start Run 
15. Define a file name for the run file and click Save to begin the run 

Data Analysis on CFX Real-Time PCR Systems 
The run data file will open automatically after the run.  To open a file that has been closed, click File -> 
Open -> Data File -> Select the data file from the menu.   
 
To analyze the data, adjust the baseline and threshold values for each fluorophore in the Quantification 
Tab. 
 

1. Select Settings > Cycles to Analyze and enter “5” in the first cell 
2. Select all wells by clicking the top-left corner of the plate map below the amplification plot 
3. Right-click anywhere in the amplification plot and select Chart Settings.  Click Axis Scale tab and 

uncheck the Auto Scale button.  Click OK to apply. 
4. Select Log Scale by checking the box in the lower right of the amplification plot 

 
5. Deselect HEX, Texas Red, and Cy5 fluorophores by unchecking the corresponding boxes under the 

amplification plot.  Only the FAM box should be selected 
 

 
 

6. Drag the bold, horizontal threshold line so that it intersects with the highest-amplitude amplification 
trace at cycle 45 

7. Manually define the baseline for all traces.  Select Settings > Baseline Threshold.  Highlight all wells 
by clicking on the top-left corner of the table.  Below the table, apply the following for All Selected 
Rows:  Begin: 3 and End: 15 
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8. Set the FAM threshold to 10% of the maximum amplitude trace signal. Confirm that the ‘User 
Defined’ radio button is selected. Set the value to 10% of that shown (e.g., the initial value of 
13665.58 in the example below would become 1366.558). Click OK to apply.  

 
 

9. Adjust baseline and define the threshold for each of the HEX, Texas Red, and Cy5 channels by 
selecting the appropriate fluorophore in Step 1 and repeating Step 5 through Step 8. 

Applied Biosystems 7500 Fast Dx Real-Time Instrument Setup  
The following instructions are essential for testing SARS-CoV-2/FluA/FluB RT-PCR Assay with the 7500 
Fast Real-Time PCR system.  For more detailed information about how to set up plates and cycling 
protocols, refer to the Applied Biosystems 7500 Fast Real-Time PCR instrument manual.  

1. Launch the 7500 software 
2. Select File -> New from the menu bar 
3. Define the following 

a. Assay – Standard Curve (Absolute Quantitation) 
b. Container – 96-Well Clear 
c. Template – Blank Document 
d. Run Mode – Standard 7500 

4. Assign the report dye as defined in Table 9.   
 

Table 9: Required Reporter Dyes 
Reporter Dye Detector 

FAM SARS-CoV-2 
HEX Influenza A 

TEXAS RED (TRed) RNase P 
Cy 5 Influenza B 

 
Note:  For the Inf A assay, the VIC channel is applicable for detecting this target.   
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5. Select Passive Reference -> None 
6. Define the cycling protocol using the values listed in Table 10.   

 
Table 10. Thermal Cycling Protocol for AB7500 

Cycling Step Temperature (°C) Time Number of Cycles 
Reverse transcription 50 10 minutes 1 

Enzyme activation 95 10 minutes 1 
Denaturation 95 10 seconds 45 Annealing/extension 60 30 seconds 

 
7. Define the data collection step by selecting Stage 3, step 2 (60.0 @ 0:30) from the Data Collection 

dropdown menu, select Stage 3, Step 2 (60.0 @ 0:30), see Figure 2 
 
Figure 2: Data Collection Dropdown Menu for AB7500 Dx 

 

Data Analysis on Applied Biosystems 7500 Dx Fast Real-Time 
The following instructions are essential for analyzing the SARS-CoV-2 RT-PCR with the 7500 Fast Dx Real-
Time PCR system.  For more detailed information about data analysis, refer to the Applied Biosystems 
7500 Fast Real-Time PCR instrument manual. 
 
Setting Baseline and Threshold Values 
 

1. Select File -> Open -> Select the data file to be analyzed 
2. Select Analysis Settings to open the “Analysis Setting-Standard curve” dialog box. 

a. Select All under Detector. Select Manual Baseline. Make sure the Start (cycle) is 3 and the 
End (cycle) is 15.  

b. Click OK and Reanalyze to close the dialog box 
3. Find the maximum RFU value in each channel for the entire plate by following the steps below: 

a. Select all wells 
b. Select File -> Export -> Delta Rn and save the csv file. 
c. Open the csv file in step b using Excel and select all cells by clicking on the upper left corner 

of the spreadsheet. 
d. Select Insert -> PivotTable.  Click OK of the dialog box without changing any of the default 

setting 
e. In the PivotTable Fields, drag Detector to the Rows area and Cycle 45 to the Values area.  
f. Click “Sum of Cycle 45” in the Values box (lower right). 
g. Select “Value field settings” and change to “Max” 
h. Make note of the maximum RFU value for each channel (data presented in pivot table) 

4. Return to the RT-PCR run file. Select Analysis Settings to open the “Analysis Setting-Standard 
curve” dialog box. 

a. Select FAM under Detector.  
b. Select Manual Ct  
c. Enter 10% of the value of the maximum RFU noted for the FAM channel in step 3-h. 
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d. Repeat a-c for the HEX, TRed, and Cy5 channels using the % Maximum RFU shown in Table 
11. 
 
Table 11. Percent Maximum RFU to Define Threshold Value 

Channel % Maximum RFU 
FAM 10% 
HEX 5% 
TRed 10% 
Cy5 10% 

 
e. Click OK and Reanalyze to close the dialog box. 

Interpretation of Results 
All test controls should be examined before interpretation of patient results.  If the controls are not valid, 
the patient results cannot be interpreted.  

Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit Controls – NTC, 
Positive and Negative 

No Template Control (NTC) 
The amplification curves for the NTC reactions should not cross the threshold before cycle 40 in any 
channel (FAM, HEX, Cy5, or Texas Red). If any of the NTC reactions cross the threshold before cycle 40, 
sample contamination may have occurred. Invalidate the run and repeat the assay with the residual 
extracted nucleic acid with strict adherence to the guidelines. If the repeat test result is positive, re-
extract, and retest all samples included in that batch. 

Negative Control (NC) 
The amplification curves for the SARS-CoV-2, Flu, RSV Negative Run Control must cross the threshold 
before cycle 40 (Cq < 40) in the Texas Red channel (RP) and fail to cross or cross the threshold after 
cycle 40 in the FAM, HEX, and Cy5 channels. If the NC fails, the run is repeated with residual extracted 
nucleic acid (all samples, NTC, PC and, NC). If the NC fails again, the extraction must be repeated for all 
samples included in that batch. 

Positive Control (PC) 
The amplification curves for the SARS-CoV-2, Flu, RSV Positive Run Control must cross the threshold 
before cycle 40 (Cq < 40) in all four channels (FAM, HEX, Cy5, and Texas Red).  If the PC fails, the run is 
repeated with residual extracted nucleic acid (all samples, NTC, PC and, NC). If the PC fails again, the 
extraction must be repeated for all samples included in that batch. 

Examination and Interpretation of Patient Specimen Results 

Assessment of clinical specimen test results must be performed after the positive and negative controls 
have been confirmed. The expected performance of the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-
PCR Assay Kit controls is shown in Table 12. 
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Table 12. Expected Performance of Controls in the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay 
Kit 
Control 

Type 
External Control 

Name Used to Monitor FluA FluB SC2 RP Expected Cq 

NTC RNase/DNase 
free water 

Reagent and/or 
environmental 
contamination 

Negative Negative Negative Negative Cq ≥40.00 for FluA, 
FluB, SC2, and RP 

Negative 
SARS-CoV-2, Flu, 

RSV Negative 
Run Control 

Reagent and/or 
environmental 
contamination; 

extraction failure 

Negative Negative Negative Positive 
Cq < 40.00 for RP 

 

Cq ≥40.00 for FluA, 
FluB, and SC2 

Positive 
SARS-CoV-2, Flu, 
RSV Positive Run 

Control 

Substantial reagent 
failure including 

primer and probe 
integrity 

Positive Positive Positive Positive Cq < 40.00 for FluA, 
FluB, SC2, and RP  

 
If any control does not meet these criteria, the test may have been improperly set up or executed, or 
reagent or equipment may have experienced malfunction or failure.  Invalidate the run and retest 
according to the above procedures. 

RP (Internal Control) 
All clinical samples must exhibit positive signals with the RP primers and probe (Cq < 40) in the Texas 
Red channel, indicating the presence of the human RP gene. Failure to detect RP in any clinical 
specimens may indicate:  
● Improper extraction of nucleic acid from clinical materials resulting in loss of RNA and/or RNA 

degradation  
● Absence of sufficient human cellular material due to poor collection or loss of specimen 

integrity 
● Improper assay set up and execution 
● Reagent or equipment malfunction 

If the RP assay does not produce a positive result for a human clinical specimen, interpret as follows:  
● If any of the FluA, FluB, and SC2 targets is/are positive, even in the absence of a positive RP, the 

result should be considered valid. Some samples may fail to exhibit RP as positive (Cq < 40) due 
to low cell numbers in the original clinical sample. A negative RP signal does not preclude the 
presence of FluA, FluB, and SC2 viral RNA in a clinical specimen.  

● If all FluA, FluB, and SC2 markers and RP are negative for the specimen, the result should be 
considered invalid. If residual specimen is available, repeat the extraction procedure and repeat 
the test. If all markers remain negative after retesting, report the results as invalid and a new 
specimen should be collected.  

FluA, FluB, and SC2 Markers 
When positive, negative, and NTC controls exhibit the expected results: 
● Positive result: One or more of the viral amplification curves (FluA, FluB, and/or SC2) crosses 

the threshold BEFORE 40 cycles (Cq < 40.00). Multiple viruses may be detected in a single 
specimen.  

● Negative result:  All viral amplification curves (FluA, FluB, and SC2) fail to cross the threshold or 
cross the threshold AFTER 40 cycles (Cq ≥ 40.00) AND the RP amplification curve crosses the 
threshold BEFORE 40 cycles (Cq ≤ 40.00). 
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● Invalid result: Amplification curves for FluA, FluB, and SC2 fail to cross the threshold or cross the 
threshold AFTER 40 cycles (Cq ≥ 40.00) but the RP also fails to cross the threshold BEFORE 40 
cycles (Cq < 40.00). Repeat testing of the specimen nucleic acid and/or re-extract and repeat 
the assay.  If the specimen remains invalid upon retest then the collection of a new specimen 
and subsequent testing should be considered. 

For ease of interpretation, refer to the guide in Table 13. 

Table 13. Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit Results Interpretation Guide 
FluA 

Result 
FluB 

Result 
SC2 

Result 
RP 

Result Interpretation Actions 

Positive 
(Cq < 40) 

Negative 
(Cq ≥ 40 or 

N/A) 

Negative 
(Cq ≥ 40 or 

N/A) 
Positive or 
Negative Influenza A detected 

Report results to sender and 
appropriate public health 

authorities. 
Negative 
(Cq ≥ 40 or 

N/A) 
Positive 
(Cq < 40) 

Negative 
(Cq ≥ 40 or 

N/A) 
Positive or 
Negative Influenza B detected 

Report results to sender and 
appropriate public health 

authorities. 
Negative 
(Cq ≥ 40 or 

N/A) 

Negative 
(Cq ≥ 40 or 

N/A) 

Positive 
(Cq < 40) 

Positive or 
Negative SARS-CoV-2 detected 

Report results to sender and 
appropriate public health 

authorities. 

Positive 
(Cq < 40) 

Positive 
(Cq < 40) 

Negative 
(Cq ≥ 40 or 

N/A) 

Positive or 
Negative 

Influenza A and 
Influenza B detected 

Report results to sender and 
appropriate public health 

authorities. 

Positive 
(Cq < 40) 

Negative 
(Cq ≥ 40 or 

N/A) 

Positive 
(Cq < 40) 

Positive or 
Negative 

Influenza A and 
SARS-CoV-2 detected 

Report results to sender and 
appropriate public health 

authorities. 

Positive 
(Cq < 40) 

Positive 
(Cq < 40) 

Positive 
(Cq < 40) 

Positive or 
Negative 

Influenza A, 
Influenza B, and 

SARS-CoV-2 detected 

Report results to sender and 
appropriate public health 

authorities. 
Negative 
(Cq ≥ 40 or 

N/A) 

Positive 
(Cq < 40) 

Positive 
(Cq < 40) 

Positive or 
Negative 

Influenza B and 
SARS-CoV-2 detected 

Report results to sender and 
appropriate public health 

authorities. 

Negative 
(Cq ≥ 40 or 

N/A) 

Negative 
(Cq ≥ 40 or 

N/A) 

Negative 
(Cq ≥ 40 or 

N/A) 

Positive 
(Cq < 40) Virus not detected 

Report results to sender and 
appropriate public health 

authorities. Consider testing for 
other respiratory viruses. 

Negative 
(Cq ≥ 40 or 

N/A) 

Negative 
(Cq ≥ 40 or 

N/A) 

Negative 
(Cq ≥ 40 or 

N/A) 

Negative 
(Cq ≥ 40 or 

N/A) 
Invalid 

Repeat extraction and RT-PCR. If 
the repeated result remains 

invalid, consider collecting a new 
specimen from the patient. 

N/A; Negative, no detectable Cq value 

Limitations 
1. Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit has only been evaluated for use in 

combination with the SARS-CoV-2 RT-PCR Oligos, Reliance One-Step Multiplex RT-qPCR Supermix, and 
the Exact Diagnostics SARS-CoV-2, Flu, RSV Positive and Negative Run Controls for use on the CFX Opus 
96, CFX96 Touch, CFX96 Dx, and Applied Biosystems 7500 Fast DX Real-Time PCR Systems. 

2. The clinical performance has not been established in all circulating variants but is anticipated to be 
reflective of the prevalent variants in circulation at the time and location of the clinical evaluation. 
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Performance at the time of testing may vary depending on the variants circulating, including newly 
emerging strains of SARS-CoV-2 and their prevalence, which change over time. 

3. Reliable results depend on proper sample collection, storage, and handling procedures. 
4. This test is used for the detection of viral RNA in nasopharyngeal swabs and anterior nasal swabs 

collected in a Universal Transport Medium (UTM) or Universal Viral Transport System (UVT). Testing of 
other sample types with Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit may result in inaccurate 
results. 

5. Detection of viral RNA may be affected by sample collection methods, patient factors (for example, 
presence of symptoms), and/or stage of infection.  

6. The output of the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit is a qualitative assessment 
of positive patient samples. The user assesses RT-PCR results for controls and patient samples to make 
a qualitative call of viral RNA detected or not detected. The values reported should not be used or 
interpreted as quantitative. 

7. As with any molecular test, mutations within the target regions of Reliance SARS-CoV-2/FluA/FluB RT-
PCR Assay Kit could affect primer and/or probe binding resulting in a failure to detect the presence of 
a virus.  

8. Due to inherent differences between technologies, it is recommended that users perform method 
correlation studies in their laboratory to qualify technology differences before switching from one 
technology to the next. One hundred percent agreement between the results should not be expected 
due to the aforementioned differences between technologies. Users should follow their own specific 
policies/procedures. 

9. Individuals who received nasally administered influenza A/B vaccine may have positive influenza test 
results for up to three days after vaccination. 
http://www.cdc.gov/mmwr/preview/mmwrhtml/rr57e717a1.htm 

 

Conditions of Authorization for the Laboratory 
The Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit Letter of Authorization, along with the 
authorized Fact Sheet for Healthcare Providers, the authorized Fact Sheet for Patients, and authorized 
labeling are available on the FDA website:  https://www.fda.gov/medical-devices/coronavirus-disease-
2019-covid-19-emergency-use-authorizations-medical-devices/vitro-diagnostics-euas. 

 
However, to assist clinical laboratories using the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit, 
(“your product” in the conditions below), the relevant Conditions of Authorization are listed below: 
 

A. Authorized laboratories1 using your product must include with test result reports all authorized 
Fact Sheets.  Under exigent circumstances, other appropriate methods for disseminating these 
Fact Sheets may be used, which may include mass media. 
 

B. Authorized laboratories using your product must use your product as outlined in the authorized 
labeling. Deviations from the authorized procedures, including the authorized instruments, 
authorized extraction methods, authorized clinical specimen types, authorized control materials, 
authorized other ancillary reagents and authorized materials required to use your product are not 
permitted. 

 

http://www.cdc.gov/mmwr/preview/mmwrhtml/rr57e717a1.htm
https://www.fda.gov/medical-devices/coronavirus-disease-2019-covid-19-emergency-use-authorizations-medical-devices/vitro-diagnostics-euas
https://www.fda.gov/medical-devices/coronavirus-disease-2019-covid-19-emergency-use-authorizations-medical-devices/vitro-diagnostics-euas


Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit 

 
10000135012, Rev. A – Instructions for Use  24 

C. Authorized laboratories that receive your product must notify the relevant public health 
authorities of their intent to run your product prior to initiating testing.  
 

D. Authorized laboratories using your product must have a process in place for reporting test results 
to healthcare providers and relevant public health authorities, as appropriate.  

 
E. Authorized laboratories must collect information on the performance of your product and report 

to DMD/OHT7-OIR/OPEQ/CDRH (via email: CDRH-EUA-Reporting@fda.hhs.gov) and Bio-Rad 
Technical Support at 1-800-4BIORAD (1-800-424-6723) about any suspected occurrence of false 
positive or false negative results and significant deviations from the established performance 
characteristics of your product of which they become aware. 

 
F. All laboratory personnel using your product must be appropriately trained in PCR techniques and 

use appropriate laboratory and personal protective equipment when handling this kit and use 
your product in accordance with the authorized labeling. 
 

G. You, authorized distributors, and authorized laboratories using your product must ensure that any 
records associated with this EUA are maintained until otherwise notified by the FDA.  Such records 
will be made available to the FDA for inspection upon request. 

 
1 The letter of authorization refers to, “Laboratories certified under the Clinical Laboratory Improvement 
Amendments of 1988 (CLIA), 42 U.S.C. §263a, that meet requirements to perform high complexity tests” 
as “authorized laboratories.” 
 

Analytical Performance Characteristics 

Analytical Sensitivity 
LoD Using Live Influenza Viruses 

To determine the sensitivity of the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit to detect low 
viral loads, a limit of detection (LoD) study was conducted.  An initial test was performed to identify the 
viral titer range to conduct LoD studies. The LoD of each primer/probe set was determined using contrived 
samples prepared by titrating each virus separately into a background of pooled SC2/FluA/FluB negative 
nasopharyngeal swab matrix before nucleic acid purification. The viral strains used and stock concentration 
are described in Table 14. For each dilution point, 5 replicates were extracted using the QIAGEN QIAamp 
Viral RNA Mini Kit (140 µL sample input and 60 µL elution volume), and the nucleic acid from these 
extractions was tested immediately with the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit on 
the CFX96 Touch Real-Time PCR Instrument.  Results from the range-finding runs, shown in Table 15, 
indicate that the lowest level at which all replicates are positive for influenza A is 0.618 TCID50/mL, for 
influenza B is 1.07 TCID50/mL and for SARS-CoV-2 is 953 copies (cp)/mL.    

 
 
 
 

mailto:CDRH-EUA-Reporting@fda.hhs.gov
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Table 14. Stock Viral Strains used for LoD Studies 
Virus Strain Source Catalog No. Stock Concentration 

Influenza A* H1N1 (A/PR/8/34) ATCC VR-1469 15.81E06 TCID50/mL 
6.26E09 cp/mL 

Influenza B* (Lee/40) ATCC VR-1535 2.81E06 TCID50/mL 
1.03E10 cp/mL 

SARS-CoV-2 2019-nCoV/USA-WA1/2020 ATCC VR-1986HK 2.44E08 cp/mL 
*Live cultured virus 

Table 15. FluA, FluB and SC2 LoD Range Finding 

Virus TCID50 / 
mL #Positive Rep 1 

(Cq) 
Rep 2 
(Cq) 

Rep 3 
(Cq) 

Rep 4 
(Cq) 

Rep 5 
(Cq) 

Influenza A 

9.88 5/5 31.98 32.06 32.30 31.72 32.10 
2.47 5/5 34.42 34.05 33.55 34.02 35.32 

0.618 5/5 35.29 36.62 37.51 38.09 36.50 
0.154 2/5 37.65 37.71 N/A N/A N/A 

0.0386 1/5 37.51 N/A N/A N/A N/A 

Influenza B 

68.6 5/5 26.68 26.64 26.92 26.87 27.19 
8.58 5/5 30.57 30.81 30.96 30.33 30.55 
1.07 5/5 33.30 33.25 33.15 33.74 32.81 

0.1341 3/5 34.61 37.01 35.27 N/A N/A 
0.0168 0/5 N/A N/A N/A N/A N/A 

Virus cp/mL #Positive Rep 1 
(Cq) 

Rep 2 
(Cq) 

Rep 3 
(Cq) 

Rep 4 
(Cq) Rep5 (Cq) 

SARS-CoV-2 

488,000 5/5 28.00 28.15 28.21 28.07 28.04 
61,000 5/5 31.26 31.18 31.17 31.41 31.42 
7,625 5/5 34.91 34.90 34.41 34.35 34.36 
953 5/5 37.37 39.08 39.32 38.32 37.29 
119 1/5 N/A N/A N/A 39.85 N/A 
14.9 0/5 N/A N/A N/A N/A N/A 

N/A; Negative, no detectable Cq value 
 
Limit of Detection (LoD) - Confirmation 
The FluA, FluB, and SC2 LoD were determined using the same contrived sample procedure described for 
the range-finding study.  A 2-fold dilution series was performed based on the range-finding study.  For each 
dilution point, 20 replicates were extracted using the QIAGEN QIAamp Viral RNA Mini Kit (140 µL sample 
input and 60 µL elution volume). The nucleic acid from these extractions was tested immediately with the 
Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit on the CFX Opus 96, CFX96 Touch, CFX96 Dx, and 
AB 7500 Fast Dx.  The LoD was determined as the lowest amount of virus detected, with at least 95% of 
the replicates testing positive. 

Results are presented in Table 16, Table 17, and Table 18 and are summarized in Table 19.  All controls 
performed as expected. The LoD for SARS-CoV-2 ranges from 125 to 250 cp/mL on the different 
instruments. The LoD for influenza A ranges from 1.26 to 2.52 TCID50/mL on the different instruments. The 
LoD for influenza B is 0.23 TCID50/mL on all instruments. Each virus has equivalent LoD performance (within 
2-3 fold) across all validated instruments with the Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit. 
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Table 16. Limit of Detection of the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit in Detecting 
the SARS-CoV-2 Virus  

SARS-CoV-2 
copies/mL 

CFX96 Touch CFX96 Dx CFX Opus 96  AB7500 Fast Dx 
SC2 Positive 

replicates/Total 
replicates 

SC2 Positive 
replicates/Total 

replicates 

SC2 Positive 
replicates/Total 

replicates 

SC2 Positive 
replicates/Total 

replicates 
250 19/20 20/20 20/20 19/20 
125 19/20 14/20 15/20 13/20 
62.5 12/20 11/20 14/20 15/20 

31.25 5/20 7/20 13/20 6/20 
 
Table 17. Limit of Detection of the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit in Detecting 
the FluA Virus 

FluA  
TCID50/mL 

CFX96 Touch CFX96 Dx CFX Opus 96 AB7500 Fast Dx 
FluA Positive 

replicates/Total 
replicates 

FluA Positive 
replicates/Total 

replicates 

FluA Positive 
replicates/Total 

replicates 

FluA Positive 
replicates/Total 

replicates 
5.04 20/20 20/20 20/20 20/20 
2.52 19/20 20/20 20/20 20/20 
1.26 11/20 18/20 15/20 19/20 
0.63 8/20 14/20 14/20 18/20 

 
Table 18. Limit of Detection of the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit in Detecting 
the FluB Virus 

FluB  
TCID50/mL 

CFX96 Touch CFX96 Dx CFX Opus 96 AB7500 Fast Dx 
FluB Positive 

replicates/Total 
replicates 

FluB Positive 
replicates/Total 

replicates 

FluB Positive 
replicates/Total 

replicates 

FluB Positive 
replicates/Total 

replicates 
0.92 20/20 20/20 20/20 20/20 
0.46 20/20 19/20 19/20 19/20 
0.23 20/20 20/20 20/20 20/20 
0.12 17/20 18/20 16/20 15/20 

 
Table 19. Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit LoD Summary 

Instrument SARS-CoV-2 FluA* FluB* 
CFX96 Touch 125 copies/mL 2.52 TCID50/mL 1002 copies/mL 0.23 TCID50/mL 862 copies/mL 

CFX96 Dx 250 copies/mL 2.52 TCID50/mL 1002 copies/mL 0.23 TCID50/mL 862 copies/mL 
CFX Opus 96 250 copies/mL 2.52 TCID50/mL 1002 copies/mL 0.23 TCID50/mL 862 copies/mL 

AB7500 Fast Dx 250 copies/mL 1.26 TCID50/mL 501 copies/mL 0.23 TCID50/mL 862 copies/mL 
*Live cultured virus 

The interfering substances study used live contemporary influenza A (A/Kansas/14/2017) and influenza B 
(Colorado/06/2017 [Victoria]) strains. An  additional confirmatory LoD study was performed on these 
strains to confirm assay sensitivity.  The Bio-Rad CFX Opus 96 is considered representative of all the 
instruments validated for use with the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit, as 
demonstrated during the LoD study shown previously and, therefore the confirmatory LoD study was 
performed only on this instrument.  The LoD of each strain was determined separately using 20 
independently extracted contrived samples prepared at various dilutions in negative clinical NP swab 
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matrix. See Table 20 for for the confirmatory LoD study data. The LoD for the contemporary influenza A 
and B strains was 589 and 593 copies/mL, respectively. 
 
Table 20. LoD Summary for Contemporary Live Influenza Strains on the CFX Opus 96  

Influenza A (A/Kansas/14/2017) 
Concentration Units Positive Replicates/Total Replicates copies/mL TCID50/mL 
1179 2.70 20/20 
589 1.35 20/20 
295 0.68 15/20 
147 0.34 14/20 

Influenza B (Colorado/06/2017 [Victoria]) 
Concentration Units Positive Replicates/Total Replicates copies/mL TCID50/mL 
1186 8.8E-02 20/20 
593 4.4E-02 20/20 
296 2.2E-02 16/20 
148 1.1E-02 6/20 

 

LoD Using Inactivated Influenza Viruses 

The co-infection and carryover studies were completed using inactivated viral organisms (Influenza A 
H1N1pdm and Influenza B Florida/02/06). In addition to the live cultured virus LoD study described above 
(for both contemporary and non-contemporary strains), the LoD of the Bio-Rad Reliance SARS-CoV-
2/FluA/FluB RT PCR Assay kit was also established using inactivated viral strains (Table 21) in clinical 
negative NP swab matrix on all four claimed instrument platforms.  
 
LoD results (Table 22 and 23 and summarized in Table 24) demonstrate the limit of detection for 
inactivated influenza A virus is 500 to 1000 copies/mL and 250 to 500 copies/mL for inactivated influenza 
B virus. Each virus has equivalent LoD performance (within 2-3 fold) across all validated instruments with 
the Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit. 

Table 21. Stock Inactivated Viral Strains Used for LoD Studies 
Virus Strain Source Catalog No. Stock Concentration 

Influenza A H1N1pdm Zeptometrix 0810311CFNHI 2.26E07 copies/mL 
Influenza B Florida/02/06 Zeptometrix NATFLUB-ST 4.12E09 copies/mL 
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Table 22. Limit of Detection of the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit in Detecting 
Inactivated FluA Virus 

FluA  
cp/mL 

CFX96 Touch CFX96 Dx CFX Opus 96 AB7500 Fast Dx 

FluA Positive 
replicates/Total 

replicates 

FluA Positive 
replicates/Total 

replicates 

FluA Positive 
replicates/Total 

replicates 

FluA Positive 
replicates/Total 

replicates 
1000 20/20 20/20 20/20 20/20 
500 19/20 20/20 18/20 17/20 
250 12/20 13/20 10/20 12/20 
125 8/20 16/20 9/20 14/20 

 
Table 23. Limit of Detection of the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit in Detecting 
Inactivated FluB Virus 

FluB  
cp/mL 

CFX96 Touch CFX96 Dx CFX Opus 96 AB7500 Fast Dx 

FluB Positive 
replicates/Total 

replicates 

FluB Positive 
replicates/Total 

replicates 

FluB Positive 
replicates/Total 

replicates 

FluB Positive 
replicates/Total 

replicates 
1000 20/20 20/20 20/20 20/20 
500 20/20 20/20 20/20 20/20 
250 20/20 20/20 18/20 18/20 
125 17/20 17/20 10/20 18/20 

 
Table 24. Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit LoD Summary for Inactivated FluA 
and FluB Viruses  

Instrument Inactive FluA Inactive FluB 
CFX96 Touch 500 copies/mL 250 copies/mL 

CFX96 Dx 500 copies/mL 250 copies/mL 
CFX Opus 96 1000 copies/mL 500 copies/mL 

AB7500 Fast Dx 1000 copies/mL 500 copies/mL 
 

Matrix Equivalency 

A matrix equivalency study was performed to determine equivalent performance between contrived 
specimens prepared using clinical negative NP matrix and contrived specimens using simulated matrix.  
Contrived specimens in simulated matrix were utilized for the co-infection and carryover studies. To 
determine matrix equivalency, a selection of inactivated and live culture viruses from the LoD studies 
described previously were used to compare NP matrix to simulated matrix as listed in Table 25.  

Table 25. Viral strains used for matrix equivalency study  

Virus Strain LoD Stock Concentration 3x LoD 
cp/mL Vendor (P/N) cp/mL TCID50/mL cp/mL TCID50/mL 

SARS-CoV-
2 

2019-nCoV/USA-
WA1/2020  250 N/A 2.44E+08 N/A 750 ATCC (VR-

1986HK) 

Influenza 
A 

H1N1 (A/PR/8/34) 1002 2.52 6.26E+09 1.58E+06 3006 ATCC (VR-1469) 
H3N2 
(Kansas/14/17)  589 1.35 1.60E+08 3.89E+04 1767 Zeptometrix 

(0810586CF) 
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H1N1pdm 1000 N/A 2.26E+07 N/A 3000 Zeptometrix 
(0810311CFNHI) 

Influenza 
B 

Lee/40 862 0.23 1.03E+10 2.81E+06 2586 ATCC (VR-1535) 
Colorado/06/2017 
(Victoria) 593 0.044 4.60E+10 3.55E+05 1779 Zeptometrix 

(0810573CF) 

Florida/02/2006 500 N/A 4.12E+09 N/A 1500 Zeptometrix 
(NATFLUB-ST) 

N/A; Inactivated strain, no TCID50 concentration available  

Three replicates per strain and per matrix type were created at 3-fold their respective LoD. The NP matrix 
samples were extracted using QIAGEN QIAamp Viral RNA Mini Kit (140 µL sample input and 60 µL elution 
volume). The nucleic acid from these extractions and the simulated matrix samples was tested with the 
Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit on the CFX Opus 96.  All controls performed as 
expected. Cq values at the testing concentration for each analyte were comparable between simulated 
and clinical matrix (i.e., ∆Cq <1.5) with the exception of H3N2 which had a ∆Cq of 3.4. The reason for this 
discrepancy is unclear; however, this strain of influenza A was not used in any additional studies with 
simulated matrix and the results were therefore deemed acceptable. The results are summarized in Table 
26.  

Table 26. Matrix equivalency study results 

Virus Strain 
Clinical NP Matrix Simulated Matrix 

∆Cq Positive 
replicates Avg Cq StdDev Positive 

replicates Avg Cq StdDev 

SARS-CoV-2 2019-nCoV/USA-WA1/2020  3/3 37.80 1.73 3/3 36.50 0.23 1.30 

Influenza A 
H3N2 (Kansas/14/17)  3/3 36.18 0.80 3/3 32.76 0.10 3.42 
H1N1 (A/PR/8/34) 3/3 38.82 0.67 3/3 37.48 0.72 1.34 
H1N1pdm 3/3 33.58 1.15 3/3 34.51 0.28 -0.93 

Influenza B 
Colorado/06/2017 (Victoria) 3/3 34.59 0.39 3/3 34.22 0.18 0.37 
Lee/40 3/3 36.18 2.49 3/3 37.42 0.43 -1.24 
Florida/02/2006 3/3 36.18 0.82 3/3 35.75 0.31 0.43 

StdDev; Standard Deviation of Cq values; ∆Cq = Avg CqClinical – Avg CqSimulated 

Inclusivity 
Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit contains primer/probe sets (FluA, FluB, and SC2) 
targeting RNA of influenza A, influenza B, and SARS-CoV-2 viruses. The oligonucleotide primers and probes 
for the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit are the same sequences as the CDC 
Influenza SARS-CoV-2 (Flu SC2) Multiplex Assay (EUA received July 2, 2020).   
 
Bio-Rad is using the CDC validated oligonucleotide primers and probe sequences by Right of Reference.  
The CDC inclusivity in silico analysis for SARS-CoV-2 as described in the CDC Influenza SARS-CoV-2 (Flu SC2) 
Multiplex Assay IFU is referenced below.  

 
SARS-CoV-2 In Silico Analysis: 
CDC tested the inclusivity/exclusivity of each primer and probe oligonucleotide sequence for the SARS-
CoV-2 target of the assay via NCBI BLAST+ against the nr/nt database, updated on 04/25/2020 
(N=57791697 sequences analyzed), which confirmed only perfect matches to SARS-CoV-2 and close 
matches to SARS-CoV-2 ancestors (i.e., no genomes identified with more than 2 nt mismatches).  
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Additionally, Bio-Rad performed an alignment with the oligonucleotide primer and probe sequences of the 
SC2 assay with all publicly available nucleic acid sequences for SARS-CoV-2 in the Global Initiative on 
Sharing All Influenza Data (GISAID, https://www.gisaid.org) and from the GenBank databases spanning 
from April 1, 2020 to November 15, 2020 to demonstrate the predicted inclusivity of the SC2 assay. An 
evaluation of 197,261 available SARS-CoV-2 sequences in GISAID and 38,738 available SARS-CoV-2 
sequences in GenBank was done for this study (N=235,999 total sequences). This count includes both 
complete and partial genomes; only genomes with complete SC2 assay binding sites were analyzed. Results 
confirmed perfect and close matches to SARS-CoV-2 (no genomes with the SC2 binding site were identified 
to have more than 2 nucleotide mismatches in total across both primers and probe), as shown in Table 
27a. When present, the mismatch could be found in any position of the assay binding site. The likelihood 
of one to two mismatches resulting in a significant loss in reactivity, and false negative result, is low. The 
assay and probe designs are optimized to be most efficient at annealing temperatures of 60°C, enabling 
the assay to withstand one or two mismatches. 
 
Table 27a. In silico inclusivity analysis for SARS-CoV-2 

Database Genomes 
available1 

Genomes with 
SC2 binding site2 

Genomes with 
perfect match 

Genomes with  
1 mismatch Inclusivity3  

GISAID 197,261 196,382 187,730 8,285 99.81% 
GenBank 38,738 38,442 36,911 1,512 99.95% 

TOTAL 235,999 234,824 224,641 9,797 99.84% 
1These numbers include both complete and partial genomes; some binding sites are missing due to incomplete 
genome or low-quality sequences 
2When ‘N’ is found in the primer binding site, the target was considered to be missing information and excluded 
from inclusivity calculation 
3Percentage of sequences with the SC2 binding site exhibiting ≤ 1 mismatch 
 
In addition, a variant analysis was performed against the UK, South Africa, Brazil, and California strains 
(February 2021). Results confirmed perfect matches to the SARS-CoV-2 primers/probe. The predicted 
inclusivity of the SARS-CoV-2 assay is not impacted by the currently circulating escape variants. 
 
Influenza In Silico Analysis: 
An alignment with the oligonucleotide primer and probe sequences of the FluA and FluB assays with the 
publicly available nucleic acid sequences for laboratory and contemporary strains of influenza A and 
influenza B in the GenBank database was performed to demonstrate the predicted inclusivity of the FluA 
and FluB assays. For this analysis, an evaluation of 48 available influenza A sequences and 8 available 
influenza B sequences was performed. This count includes genomes with complete assay binding sites. 
Results confirmed that 48/48 influenza A genomes and 8/8 influenza B genomes had perfect and close 
matches to Influenza A and B respectively (no genomes with the FluA or FluB binding sites were identified 
to have more than 2 nucleotide mismatches), as shown in Table 27b. These mismatches occurred towards 
the middle and 5’ end of the assays. The likelihood of one to two mismatches resulting in a significant loss 
in reactivity, and false negative result, is low. The assay and probe designs are optimized to be most 
efficient at annealing temperatures of 60°C, enabling the assay to withstand one or two mismatches. 
 
Table 27b. In silico Inclusivity Analysis for Influenza A and B 

Target Genomes 
available1 Perfect Match 1 Mismatch 2 Mismatch Inclusivity  

FluA2 48 15 22 11 100% 
FluB 8 5 3 0 100% 

1These numbers include both complete and partial genomes, all of which have the complete binding sites 
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2FluA assay includes 2 pairs of forward and reverse primers. A mismatch was not included in the total count if one of 
the two primer pairs was a match at that same position. 

 
Influenza Inclusivity (Wet Testing): 
The inclusivity of the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit was evaluated using 13 
influenza A and 9 influenza B viruses representing temporal, geographic, and genetic diversity within the 
subtype and lineage. All viral strains tested were quantified with Droplet Digital PCR to standardize 
concentration units and were prepared at two concentrations, 2x and 5x LoD (refer to Table 19 for 
Influenza A (H1N1 A/PR/8/34) and B (B/Lee/40) LoD concentrations). Samples were extracted in triplicate 
using the QIAGEN QIAamp Viral RNA Mini Kit (140 µL sample input and 60 µL elution volume) and were 
tested on the CFX Opus 96 with the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit. The 
influenza A target (FluA) generated positive results in both concentrations of the influenza A viruses 
tested. The influenza B target (FluB) generated positive results in both concentrations of the influenza B 
viruses tested. All controls performed as expected. Inclusivity evaluation results are presented below in 
Table 28.  

Table 28. Inclusivity Evaluation – Influenza 

Lineage Strain 
Designation 

Concentration Extraction 1 Extraction 2 Extraction 3 
EID50/mL or 

PFU/mL*  cp/mL SC2 
FAM 

FluA 
HEX 

FluB 
Cy5 

SC2F
AM 

FluA 
HEX 

FluB 
Cy5 

SC2 
FAM 

FluA 
HEX 

FluB 
Cy5 

A(H1N1) A/Brisbane/02/20
18 

182 2004 N/A 34.85 N/A N/A 35.16 N/A N/A 35.21 N/A 
455 5010 N/A 33.52 N/A N/A 34.03 N/A N/A 33.56 N/A 

A(H1N1) A/Christ 
Church/16/2010 

710 2004 N/A 34.91 N/A N/A 34.74 N/A N/A 34.81 N/A 
1775 5010 N/A 33.76 N/A N/A 33.62 N/A N/A 33.56 N/A 

A(H3N2)  A/Kansas/14/201
7 

127 2004 N/A 34.66 N/A N/A 34.32 N/A N/A 34.40 N/A 
318 5010 N/A 32.83 N/A N/A 32.71 N/A N/A 32.95 N/A 

A(H3N2)  A/Perth/16/2009 
93.6 2004 N/A 34.79 N/A N/A 34.84 N/A N/A 35.08 N/A 
234 5010 N/A 33.16 N/A N/A 33.61 N/A N/A 33.87 N/A 

A(H1N1) A/PR/8/34 
3.7 2004 N/A 36.05 N/A N/A 36.47 N/A N/A 36.08 N/A 
9.25 5010 N/A 34.45 N/A N/A 34.96 N/A N/A 34.87 N/A 

A(H1N1) A/WS/33 
1.6 2004 N/A 37.24 N/A N/A 38.06 N/A N/A 37.29 N/A 
4 5010 N/A 36.57 N/A N/A 35.91 N/A N/A 36.18 N/A 

A(H3N2)   A/Hong 
Kong/8/68 

0.168 2004 N/A 36.86 N/A N/A 36.50 N/A N/A 36.85 N/A 
0.42 5010 N/A 35.44 N/A N/A 35.56 N/A N/A 35.34 N/A 

A(H3N2)  A/Wisconsin/67/2
005 

341 2004 N/A 35.49 N/A N/A 35.53 N/A N/A 35.33 N/A 
853 5010 N/A 33.76 N/A N/A 33.77 N/A N/A 33.58 N/A 

A(H1N1) A1/Denver/1/57 
198 2004 N/A 35.29 N/A N/A 35.50 N/A N/A 35.45 N/A 
495 5010 N/A 34.10 N/A N/A 34.30 N/A N/A 33.80 N/A 

A(H3N2)  A/Port 
Chalmers/1/73 

518 2004 N/A 34.97 N/A N/A 35.11 N/A N/A 34.98 N/A 
1295 5010 N/A 33.89 N/A N/A 33.57 N/A N/A 33.47 N/A 

A(H3N2)  A/Victoria/3/75 
11.3 2004 N/A 36.21 N/A N/A 35.83 N/A N/A 35.66 N/A 
28.3 5010 N/A 35.06 N/A N/A 34.26 N/A N/A 34.19 N/A 

A(H1N1) A/New 
Jersey/8/76 

42.8 2004 N/A 36.50 N/A N/A 36.25 N/A N/A 36.59 N/A 
107 5010 N/A 34.62 N/A N/A 34.68 N/A N/A 34.67 N/A 

A(H1N1) A/FM/1/47 
394 2004 N/A 33.52 N/A N/A 33.52 N/A N/A 33.29 N/A 
985 5010 N/A 32.31 N/A N/A 32.24 N/A N/A 32.11 N/A 

B 
(Victoria) 

B/Colorado/06/20
17 

13.8 1724 N/A N/A 34.23 N/A N/A 34.56 N/A N/A 34.62 
34.5 4310 N/A N/A 32.73 N/A N/A 33.11 N/A N/A 33.45 

B 
(Victoria) 

B/Michigan/09/20
11 

33.3 1724 N/A N/A 35.12 N/A N/A 36.45 N/A N/A 36.05 
83.3 4310 N/A N/A 34.31 N/A N/A 34.51 N/A N/A 34.24 

B 240 1724 N/A N/A 35.51 N/A N/A 36.13 N/A N/A 36.03 
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Lineage Strain 
Designation 

Concentration Extraction 1 Extraction 2 Extraction 3 
EID50/mL or 

PFU/mL*  cp/mL SC2 
FAM 

FluA 
HEX 

FluB 
Cy5 

SC2F
AM 

FluA 
HEX 

FluB 
Cy5 

SC2 
FAM 

FluA 
HEX 

FluB 
Cy5 

(Yamagata) B/New 
Hampshire/01/20
16 

600 4310 N/A N/A 34.62 N/A N/A 34.52 N/A N/A 34.72 

B 
(Yamagata) 

B/Phuket/3073/2
013 

119 1724 N/A N/A 34.43 N/A N/A 33.81 N/A N/A 32.82 
297 4310 N/A N/A 32.55 N/A N/A 32.90 N/A N/A 31.44 

B 
(Yamagata) B/Florida/2006 

1.4 1724 N/A N/A 35.01 N/A N/A 35.15 N/A N/A 35.21 
3.5 4310 N/A N/A 34.00 N/A N/A 34.18 N/A N/A 34.38 

B B/Lee/41 
0.43 1724 N/A N/A 35.08 N/A N/A 34.28 N/A N/A 35.05 
1.08 4310 N/A N/A 33.62 N/A N/A 33.60 N/A N/A 34.02 

B B/Allen/45 
2.74 1724 N/A N/A 35.96 N/A N/A 35.97 N/A N/A 36.13 
6.85 4310 N/A N/A 34.22 N/A N/A 34.32 N/A N/A 34.72 

B  B/GL/1739/54 
64.6 1724 N/A N/A 34.82 N/A N/A 34.88 N/A N/A 34.15 
162 4310 N/A N/A 32.97 N/A N/A 33.26 N/A N/A 32.61 

B B/Maryland/1/59 
0.49 1724 N/A N/A 35.11 N/A N/A 35.28 N/A N/A 34.90 

1.23 4310 N/A N/A 33.86 N/A N/A 34.12 N/A N/A 33.47 

* - Influenza A strains: Brisbane, Christ Church, Kansas and Perth concentrations reported in EID50/mL  
 - Influenza B strains: Colorado, Michigan, New Hampshire and Phuket concentrations reported in EID50/mL 
 - Influenza A strains: A/PR/8/34 and A/WS33 concentrations reported in PFU/mL 
 - All  other Influenza A and B strains concentrations reported in CEID50/mL 
LoD on the CFX Opus 96 for influenza A and influenza B is 1002 copies/mL and 862 copies/mL; the two concentrations 
displayed in copies/mL represent 2X and 5X LoD. 
N/A; Negative, no detectable Cq value 
 
CDC Human Influenza Virus Panel (2019): 
The inclusivity of the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit was also evaluated with the 
CDC Human Influenza Virus Panel (2019), which is comprised 8 contemporary influenza A and B strains, 4 
influenza A viruses, and 4 influenza B viruses (Table 29) per the protocol provided with the panel. For each 
stock virus, a five-fold dilution series was prepared in saline. Five replicates per dilution were extracted 
using the QIAGEN QIAamp Viral RNA Mini Kit (140 µL sample input and 60 µL elution volume) and tested 
on the CFX Opus 96 with the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit. Testing the dilution 
series was performed until there was non-reactivity at two consecutive five-fold dilution levels, as shown 
by obtaining zero positive results for all five replicates. The last dilution that produced positive results in at 
least one out of the five replicates tested was considered the minimum reactive concentration and is shown 
in Table 29. All controls performed as expected.  
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Table 29. CDC Human Influenza 2019 Panel Members 

Type Subtype Influenza Viral Strain 
Stock 

Concentration 
(EID50/mL) 

Minimum Reactive 
Concentration 

(EID50/mL) 

Minimum Reactive 
Concentration 

(copies/mL) 
A H3N2 A/Perth/16/2009 108.3 2.04E+01 4.39E+02 
A H3N2 A/Kansas/14/2017 108.9 8.13E+01 1.27E+03 
A H1N1 A/Christ Church/16/2010 109.9 1.63E+02 4.57E+02 
A H1N1 A/Brisbane/02/2018 107.9 8.13E+00 8.92E+02 
B Victoria B/Michigan/09/2011 108.5 2.60E-01 1.36E+01 
B Victoria B/Colorado/06/2017 108.3 4.00E+00 5.12E+02 
B Yamagata B/New Hampshire/01/2016 108.9 4.07E+02 2.90E+03 
B Yamagata B/Phuket/3073/2013 108.9 8.13E+01 1.18E+03 

 

Analytical Specificity (Cross-Reactivity/Microbial Interference)  
Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit contains primer/probe sets (FluA, FluB, and SC2) 
targeting RNA of influenza A, influenza B, and SARS-CoV-2 viruses. The oligonucleotide primers and probes 
for the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit are the same sequences as the CDC 
Influenza SARS-CoV-2 (Flu SC2) Multiplex Assay (EUA received July 2, 2020).  Specifically, the influenza A 
and influenza B primers/probes are identical to those used in the 510(k) cleared CDC Human Influenza Virus 
Real-Time RT-PCR Diagnostic Panel (K080570 and associated special 510(k) submissions). Bio-Rad is using 
the CDC validated oligonucleotide primers and probe sequences by Right of Reference. Therefore, 
additional in silico cross-reactivity analysis with the influenza A and B primers and probes was not 
performed, and only laboratory testing to verify the analytical specificity of the Reliance assay was 
conducted.   

In silico Analysis 
An in silico analysis was performed to assess the potential for “off-panel” organisms to interfere with 
SARS-CoV-2 detection. No significant homology was observed between the SARS-CoV-2 primers and 
probe and other coronaviruses or human microflora that is predicted to lead to false results with the Bio-
Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit. 
 
Wet Testing (Absence of On-Panel Organisms) 
The cross-reactivity of each primer/probe set to viruses targeted by another component of the Bio-Rad 
Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit was evaluated by testing the influenza viruses from the 
inclusivity study (Table 30). Additionally, the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit 
was evaluated for cross-reactivity by testing other viruses and pathogens including those commonly 
found in respiratory tract (Tables 31 and 32). 

All pathogens (non-influenza viruses, bacteria, and fungi) were extracted in triplicate using the QIAGEN 
QIAamp Viral RNA Mini Kit (140 µL sample input and 60 µL elution volume). Nucleic acid from high titer 
preparations of the 64 organisms listed in Table 30 (22 influenza viruses), Table 31 (24 non-influenza 
viruses), and Table 32 (19 bacteria and fungi) representing respiratory pathogens or flora commonly 
present in human respiratory specimens and genetic near-neighbors of viruses targeted by the assay were 
tested in triplicate on the CFX Opus 96 with the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit.  
All controls performed as expected. The results are presented below in Table 30, Table 31, and Table 32. 
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Table 30. Exclusivity Evaluation – Influenza  

Lineage Strain Designation Conc.* 
Conc. 
cp/mL 

Cq 
Extraction 1 Extraction 2 Extraction 3 

SC2 
FAM 

FluA 
HEX 

FluB 
Cy5 

SC2 
FAM 

FluA 
HEX 

FluB 
Cy5 

SC2 
FAM 

FluA 
HEX 

FluB 
Cy5 

A(H1N1) A/Brisbane/02/2018 1.00E+06 1.10E+07 N/A 19.5 N/A N/A 19.34 N/A N/A 19.32 N/A 

A(H1N1) A/Christ 
Church/16/2010 1.00E+08 2.82E+08 N/A 18.04 N/A N/A 18.29 N/A N/A 18.46 N/A 

A(H3N2)  A/Kansas/14/2017 1.00E+07 1.57E+08 N/A 18.34 N/A N/A 18.56 N/A N/A 18.44 N/A 
A(H3N2)  A/Perth/16/2009 1.00E+06 2.14E+07 N/A 19.54 N/A N/A 19.45 N/A N/A 19.59 N/A 
A(H1N1) A/PR/8/34 6.70E+06 3.63E+07 N/A 14.5 N/A N/A 14.9 N/A N/A 14.94 N/A 
A(H1N1) A/WS/33 7.30E+06 9.15E+09 N/A 13.42 N/A N/A 13.75 N/A N/A 13.63 N/A 
A(H3N2)  A/Hong Kong/8/68 1.60E+06 3.57E+08 N/A 17.41 N/A N/A 17.47 N/A N/A 17.56 N/A 
A(H3N2)  A/Wisconsin/67/2005 2.30E+07 1.35E+08 N/A 18.02 N/A N/A 18.09 N/A N/A 18.08 N/A 
A(H1N1) A1/Denver/1/57 3.40E+07 3.43E+08 N/A 18.5 N/A N/A 18.48 N/A N/A 18.38 N/A 
A(H3N2)  A/Port Chalmers/1/73 2.50E+07 9.69E+07 N/A 18.63 N/A N/A 18.29 N/A N/A 18.58 N/A 
A(H3N2)  A/Victoria/3/75 1.60E+06 2.85E+08 N/A 17.34 N/A N/A 17.44 N/A N/A 17.95 N/A 
A(H1N1) A/New Jersey/8/76 5.00E+05 2.34E+07 N/A 14.04 N/A N/A 14.1 N/A N/A 14.06 N/A 
A(H1N1) A/FM/1/47 5.00E+06 2.54E+07 N/A 20.28 N/A N/A 20.05 N/A N/A 20.19 N/A 

Influenza B B/Colorado/06/2017 1.00E+06 1.25E+08 N/A N/A 18.1 N/A N/A 18.35 N/A N/A 18.07 
Influenza B B/Michigan/09/2011 1.00E+07 5.18E+08 N/A N/A 18.3 N/A N/A 18.18 N/A N/A 18.09 

Influenza B B/New 
Hampshire/01/2016 1.00E+06 7.16E+06 N/A N/A 20.69 N/A N/A 20.36 N/A N/A 20.3 

Influenza B B/Phuket/3073/2013 1.00E+07 1.45E+08 N/A N/A 18.94 N/A N/A 18.38 N/A N/A 18.43 
Influenza B B/Lee/41 1.60E+06 1.97E+09 N/A N/A 14.99 N/A N/A 15.38 N/A N/A 15.33 
Influenza B B/Allen/45 1.20E+05 4.82E+08 N/A N/A 17 N/A N/A 17.59 N/A N/A 17.17 
Influenza B B/GL/1739/54 5.00E+06 3.14E+09 N/A N/A 14.71 N/A N/A 14.67 N/A N/A 14.53 
Influenza B B/Florida/2006 3.90E+08 1.04E+09 N/A N/A 22.43 N/A N/A 22.47 N/A N/A 22.33 
Influenza B B/Maryland/1/59 6.80E+05 2.38E+09 N/A N/A 14.85 N/A N/A 23.36 N/A N/A 14.34 

*Influenza A strains: Brisbane, Christ Church, Kansas and Perth concentrations reported in EID50/mL  
*Influenza B strains: Colorado, Michigan, New Hampshire and Phuket concentrations reported in EID50/mL 
*Influenza A strains: A/PR/8/34 and A/WS33 concentrations reported in PFU/mL 
*All other influenza A and B strains concentrations reported in CEID50/mL 
N/A; Negative, no detectable Cq value 
 

 
Table 31. Exclusivity Evaluation – Non-Influenza Viruses  

Lineage 
Strain  

Designation 
Concentration

PFU/mL 

Bio-Rad Reliance SARS-CoV-2/FluA/FluB Assay Cq 
Extraction 1 Extraction 2 Extraction 3 

SC2 FluA FluB SC2 FluA FluB SC2 FluA FluB 
Adenovirus  3 1.12E+05 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Adenovirus 31 1.12E+05 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Adenovirus  4 1.11E+05 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Adenovirus 40/Dugan 8.82E+05 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Adenovirus 41/TAK 1.12E+05 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Adenovirus 5 1.12E+05 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Adenovirus 7A 1.11E+05 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Adenovirus 1 1.54E+05 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Betacoronavirus 1 OC43 1.12E+05 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Enterovirus 68 1.12E+05 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Epstein-Barr B95-8 3.50E+03 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Human 
coronavirus 

HCoV HKU-1 5.00E+04* N/A N/A N/A N/A N/A N/A N/A N/A N/A 

Parainfluenza 1 C35 5.00E+04* N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Human Rhinovirus 3.51E+03 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
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Lineage 
Strain  

Designation 
Concentration

PFU/mL 

Bio-Rad Reliance SARS-CoV-2/FluA/FluB Assay Cq 
Extraction 1 Extraction 2 Extraction 3 

SC2 FluA FluB SC2 FluA FluB SC2 FluA FluB 
Herpes Simplex, 1 MacIntyre 1.96E+05 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Varicella-Zoster  Ellen 1.96E+04 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Measles Edmonston 6.23E+05 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Mumps Enders 1.96E+04 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Cytomegalorvirus AD-169 1.64E+05 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Human metapneumovirus 2.72E+04 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Parainfluenza 2 1.12E+05* N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Parainfluenza 3 1.12E+05* N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Parechovirus A Type 3 1.12E+05 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Human respiratory 
syncytial virus A2 5.00E+04* N/A N/A N/A N/A N/A N/A N/A N/A N/A 

*Human coronavirus, Parainfluenza 1, and Human respiratory syncytial virus concentrations in copies/mL 
N/A; Negative, no detectable Cq value 
 
Table 32. Exclusivity Evaluation – Bacteria and Fungi 

Lineage (Strain Designation) Concentration 
CFU/mL 

Bio-Rad Reliance SARS-CoV-2/FluA/FluB Assay Cq 
Extraction 1 Extraction 2 Extraction 3 

SC2 FluA FluB SC2 FluA FluB SC2 FluA FluB 
Bordetella pertussis 5.00E+04 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Cornyebacterium striatum 2.00E+04 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Escherichia coli (H10407) 1.06E+07 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Haemophilus influenza (KW20) 2.00E+04 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Legionella anisa 1.40E+04 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Lactobacillus planatarum 3.00E+06 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Moraxella catarrhalis 5.00E+04 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Mycoplasma; pneumoniae  
(M129-B7) 3.00E+06 N/A N/A N/A N/A N/A N/A N/A N/A N/A 

Mycobacerium tuberculosis 1.40E+04 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Neisseria gonorrhoeae 5.00E+04 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Neisseria meningitidis 2.00E+04 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Pseudomonas aeruginosa  
(Boston 41501) 

6.64E+06 N/A N/A N/A N/A N/A N/A N/A N/A N/A 

Staphylococcus aureus, subsp. 
aureus 

1.60E+06 N/A N/A N/A N/A N/A N/A N/A N/A N/A 

Staphylococcus epidermis 3.00E+06 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Staphylococcus pneumoniae 
(TIGR4) 

3.00E+06 N/A N/A N/A N/A N/A N/A N/A N/A N/A 

Streptococcus pyogenes 3.60E+06 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Streptococcus salivarius 1.40E+04 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Candida albicans 2.09E+06 N/A N/A N/A N/A N/A N/A N/A N/A N/A 
Pneumocystis jiroveci 5.00E+04 N/A N/A N/A N/A N/A N/A N/A N/A N/A 

*Bordetella pertussis, Moraxella catarrhalis and Pneumocystis jiroveci concentrations in copies/mL 
N/A; Negative, no detectable Cq value 

Wet Testing (Presence of On-Panel Influenza Organisms) (Microbial Interference) 
The potential for cross-reaction and/or microbial interference was further assessed by testing off-panel 
virsues, bacteria and fungi in the presence of a low level of influenza viruses as representative analytes. 
The interfering pathogens were tested at the highest concentration possible (e.g. diluted ≥106 CFU/mL 
for bacteria, ≥105 PFU/mL for viruses, undiluted when pathogen stock concentration was lower) and were 
mixed with an influenza virus at 2x LoD concentration in the same sample to determine if the presence of 
the non-target organism would interfere with the detection of the influenza analyte using the Bio-Rad 
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Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit. Refer to Table 20 for Influenza A and B LoD 
concentrations of these contemporary strains.  
 
Contrived samples were created with one contemporary virus strain from each influenza type: Influenza 
A (H3N2) A/Kansas/14/2017 at 2x LoD (1178 cp/mL) and Influenza B (B/Colorado/06/2017) at 2x LoD 
(1186 cp/mL). The influenza viruses and non-influenza organisms were spiked into a clinical negative NP 
swab matrix pool at the desired concentrations. Each contrived sample was extracted using the QIAGEN 
QIAamp Viral RNA Mini Kit (140 µL sample input and 60 µL elution volume) in triplicate. The nucleic acid 
from these extractions was tested with the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit on 
the CFX Opus 96 instrument. All controls performed as expected. No microbial interference was observed 
with the pathogens tested. All samples were positive in 3/3 replicates for influenza A or influenza B. 

Interfering Substances Study   
The potential interference of substances commonly found in nasal swab samples on the sensitivity of viral 
detection by the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit was assessed in an interfering 
substance study.  This study utilized contemporary influenza A and influenza B strains, the LoD for which 
are contained in Table 33.  Refer to the LoD section for additional information. 

Table 33. Summary of LoD of Viral Strains Evaluated in the Interfering Substances Study 
Virus Strain  LoD (CFX Opus 96)  3x LoD (CFX Opus 96) 

SARS-CoV-2 2019-nCoV/USA-WA1/2020  250 cp/mL  750 cp/mL 
Influenza A H3N2 (Kansas/14/17)  589 cp/mL  1,767 cp/mL 
Influenza B Colorado/06/2017 (Victoria) 593 cp/mL 1,779 cp/mL 

 
The interfering substance study utilized contrived samples comprised of contemporary influenza viral 
strains from live influenza A, influenza B, or inactivated SARS-CoV-2 virus in a negative nasopharyngeal 
swab matrix. Contrived samples were prepared by spiking each virus individually at 3x LoD into a clinical 
negative matrix pool; a no virus control sample was also prepared. Potentially interfering substances were 
added to the contrived samples at concentrations that represent the highest levels expected in human 
respiratory patient samples based on a review of the literature as well as decision summaries of 510(k) 
cleared influenza assays. A negative control that used water as the added substance was also included.   
Each sample was extracted in triplicate using the QIAamp Viral RNA Mini Kit and tested as directed in the 
IFU on the CFX Opus 96 instrument.  

This study demonstrates these substances, except for FluMist Quadrivalent (2020-2021 Formula, 
MedImmune/AstraZeneca), do not interfere with SARS-CoV-2, influenza A, or influenza B virus detection.  
All contrived samples tested positive as expected in the presence of the interfering substance and tested 
negative in the no virus control sample (Table 34). FluMist Quadrivalent contains weakened influenza A 
and influenza B virus and, as expected, is positive for these viruses in the no virus control sample screened 
with the FluA and FluB assays. FluMist Quadrivalent does not impact the sensitivity to detect the SARS-
CoV-2 virus (Table 34). These data indicate the interfering substances at the high concentrations tested do 
not impact virus detection sensitivity of the Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit. 

Note: Individuals who received nasally administered influenza A/B vaccine may have positive influenza 
test results for up to three days after vaccination. 
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Table 34. Interfering Substance Study Results 

Substance Active Agent Conc. 
Tested 

SC2 Assay FluA Assay FluB Assay 
# Positive out 
of 3 replicates SC2 

Mean 
Cq1 

# Positive out 
of 3 replicates FluA 

Mean 
Cq1 

# Positive out 
of 3 replicates FluB 

Mean 
Cq1 SC2 

virus 
No 

virus 
FluA 
virus 

No 
virus 

FluB 
virus 

No 
virus 

Mucin Purified mucin 
protein 

40 mg/mL 3 0 37.66 3 0 37.72 3 0 37.39 

Nasal 
Cortico-
steroids 

Dexamethasone 3 mg/mL 3 0 36.04 3 0 35.46 3 0 36.65 
Fluticasone 2 mg/mL 3 0 37.12 3 0 35.95 3 0 36.09 

Mometasone 
Furoate 

1 mg/mL 3 0 35.97 3 0 35.06 3 0 35.49 

Budesonide 1 mg/mL 3 0 36.07 3 0 35.49 3 0 36.17 
Flunisolide 5 mg/mL 3 0 35.84 3 0 35.84 3 0 36.19 

Triamcinolone 
acetonide 

1.5 mg/mL 3 0 36.17 3 0 35.50 3 0 36.13 

Beclomethasone 2 mg/mL 3 0 35.85 3 0 35.90 3 0 36.41 

Throat 
Lozenges 

Benzocaine 7.5 mg/mL 3 0 37.05 3 0 36.39 3 0 36.43 
Menthol 7.5 mg/mL 3 0 38.30 3 0 36.32 3 0 36.14 

Zinc Acetate 7.5 mg/mL 3 0 37.43 3 0 36.17 3 0 36.25 
Chloraseptic 
Max Strength 
Sore Throat 

Lozenges 
(contains 

Benzocaine and 
Menthol) 

10 mg/mL 3 0 37.75 3 0 35.89 3 0 36.98 

Nasal Sprays 
or Drops 

Oxymetazoline 10 mg/mL 3 0 38.42 3 0 36.13 3 0 36.47 
Phenylephrine 0.5 mg/mL 3 0 38.40 3 0 36.26 3 0 35.97 

Sodium chloride 
w/ preservatives 

0.2 mg/mL 3 0 35.47 3 0 35.65 3 0 35.78 

Mupirocin Mupirocin 2 mg/mL 3 0 38.92 3 0 36.23 3 0 36.39 
Tobramycin Tobramycin 2 mg/mL 3 0 37.47 3 0 36.00 3 0 36.17 
Zanamivir Zanamivir 5 mg/mL 3 0 38.59 3 0 36.25 3 0 36.45 

Allergy 
Medicine 

Histaminum 
hydrochloricum 20% v/v 3 0 36.75 3 0 35.55 3 0 36.29 

Triple allergy 
defense  
(contains 

Galphimia glauca, 
Histaminum 

hydrochloricum, 
Luffa operculata, 

Sabadilla) 

20% v/v 3 0 35.37 3 0 35.79 3 0 36.53 

Sulphur 12X 10 mg/mL 3 0 35.85 3 0 35.47 3 0 35.88 
FluMist 

Quadrivalent 
Weakened 
FluA/B virus 

20% v/v 3 0 35.83 3 3 16.21 3 3 15.66 

Blood N/A 5% v/v 3 0 35.41 3 0 35.96 3 0 36.21 
Water 

(control) 
N/A 10% v/v 3 0 37.74 3 0 35.56 3 0 36.21 

N/A; Not Applicable 
1 Mean Cq for samples containing virus  
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Carryover/Cross-Contamination Study 
The effects of carryover or cross-contamination were tested on the CFX Opus 96 and CFX96 Touch. 
Contrived high concentration viral RNA samples were plated adjacent to negative samples in an alternating 
pattern and tested using the Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit. For this study, high 
concentration SC2 (Italy-IMNI1, Zeptometrix, Cat# 0810589CFHI1) = 2,000,000 cp/mL; FluA (H1N1pdm, 
Zeptometrix, Cat#0810311CFNHI) = 2,575,000 cp/mL; FluB (B/Lee/40, Exact Diagnostics, Cat# 130062) = 
2,850,000 cp/mL. The negative samples were prepared using total human RNA (Thermo Fisher, Cat. 
#AM7852) to simulate negative human specimens. Multiple runs were performed allowing for the 
detection of any run-to-run cross-contamination. There was no high concentration carryover or cross-
contamination from well-to-well or run-to-run. 

Coinfection (Competitive Interference)   
A coinfection study was performed to determine if the sensitivity of detecting a particular virus is affected 
when high levels of the other two viruses are present. Contrived samples were prepared using simulated 
matrix and the strains in Table 35. The co-infection combinations that were evaluated in this study are 
shown in Table 36.  High concentration is defined as follows: SC2 = 1,381,300 cp/mL; FluA = 2,575,000 
cp/mL; FluB = 2,850,000 cp/mL. Each test virus dilution point was analyzed in triplicate, using Bio-Rad's 
Reliance SARS-CoV-2/FluA/FluB RT-PCR Test Kit, to identify the lowest amount of virus RNA that can be 
detected in all three replicates. This test was performed on the CFX Opus 96 instrument. The NTC, positive, 
and negative controls were included in each plate; the results were as expected. 

Table 35. Virus Selected for Coinfection Study 
Virus Type Strain Company Catalog # Stock Titer (cp/mL) 

SARS-CoV-2 N/A Italy INMI1 Zeptometrix 0810589CFHI 2.28E07 
Influenza A H1N1pdm Zeptometrix 0810311CFNHI 4.12E09 
Influenza B B/Lee/40 Exact Diagnostics 130062 2.55E10   

 
Table 36. Combinations Tested for Coinfection Study 

Virus Titer 
SARS-CoV-2 High  High Serial dilution 
Influenza A High  Serial dilution High 
Influenza B Serial dilution High High 

 

Refer to Table 37 for the results of the study.  The results demonstrate that when using Bio-Rad's Reliance 
SARS-CoV-2/FluA/FluB RT-PCR Assay Kit, there is no observed loss in the sensitivity of detecting a test virus 
in samples that have high levels of other viruses present.   

  



Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit 

 
10000135012, Rev. A – Instructions for Use  39 

Table 37. Coinfection Results using the CFX Opus 96 Instrument 

Test 
Virus 

Test virus 
RNA 

copies/mL 

SC2 assay FluA assay FluB assay 
SC2 
Only 

SC2 with High 
Titer FluA/FluB 

FluA 
Only 

FluA with High 
Titer SC2/FluB 

FluB 
Only 

FluB with High 
Titer SC2/FluA 

# Pos Avg 
Cq # Pos Avg 

Cq # Pos Avg 
Cq # Pos Avg 

Cq # Pos Avg 
Cq # Pos Avg 

Cq 

SC2 

2000 3/3 34.50 3/3 34.45 0/3 N/A 3/3 24.71 0/3 N/A 3/3 23.97 
1000 3/3 35.65 3/3 35.56 0/3 N/A 3/3 24.70 0/3 N/A 3/3 24.05 
500 3/3 36.35 3/3 36.37 0/3 N/A 3/3 24.77 0/3 N/A 3/3 24.04 
250 3/3 37.66 3/3 37.81 0/3 N/A 3/3 24.66 0/3 N/A 3/3 24.01 
125 1/3 38.28 1/3 39.37 1/3* 39.98 3/3 24.73 0/3 N/A 3/3 24.04 
62.5 1/3 39.37 2/3 38.73 0/3 N/A 3/3 24.74 0/3 N/A 3/3 24.09 

0 0/3 N/A 0/3 N/A 0/3 N/A 3/3 24.66 0/3 N/A 3/3 23.98 

FluA 

2000 0/3 N/A 3/3 24.69 3/3 35.55 3/3 35.13 0/3 N/A 3/3 24.06 
1000 0/3 N/A 3/3 24.65 3/3 36.27 3/3 37.08 0/3 N/A 3/3 24.09 
500 0/3 N/A 3/3 24.67 3/3 38.27 3/3 37.77 0/3 N/A 3/3 24.06 
250 0/3 N/A 3/3 24.65 2/3 38.99 2/3 39.38 0/3 N/A 3/3 24.09 
125 0/3 N/A 3/3 24.60 2/3 38.32 1/3 39.83 0/3 N/A 3/3 24.02 
62.5 0/3 N/A 3/3 24.57 1/3 38.61 2/3 39.91 0/3 N/A 3/3 24.07 

0 0/3 N/A 3/3 24.61 0/3 N/A 0/3 N/A 0/3 N/A 3/3 24.05 

FluB 

2000 0/3 N/A 3/3 24.76 0/3 N/A 3/3 24.86 3/3 35.09 3/3 35.03 
1000 0/3 N/A 3/3 24.77 0/3 N/A 3/3 24.82 3/3 36.02 3/3 36.21 
500 0/3 N/A 3/3 24.72 0/3 N/A 3/3 24.83 3/3 37.09 3/3 36.78 
250 0/3 N/A 3/3 24.74 0/3 N/A 3/3 24.81 3/3 37.82 3/3 38.30 
125 0/3 N/A 3/3 24.63 0/3 N/A 3/3 24.74 1/3 37.89 2/3 38.65 
62.5 0/3 N/A 3/3 24.72 0/3 N/A 3/3 24.82 0/3 40.11 0/3 N/A 

0 0/3 N/A 3/3 24.68 0/3 N/A 3/3 24.78 0/3 N/A 0/3 N/A 

N/A; Negative, no detectable Cq value 
*One of the three SARS-CoV-2 replicates at 125 copies/mL showed a delayed Cq of 39.98 for FluA. Although considered a positive 
FluA result, this positive replicate is due to trace contamination levels while preparing and processing the high-titer contrived 
samples for this study and considered unrelated to cross-reactivity of the assays. 
 
 

Precision/Repeatability 
The within-laboratory precision of the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit was 
established using two reagent lots and two instruments, the CFX Opus 96 and the CFX96 Touch RT-PCR 
Systems. The precision panel consisted of negative samples as well as individually spiked live cultured 
influenza A and influenza B viruses that were used in the LoD studies (H1N1 A/PR/8/34, ATCC, Cat# VR-
1469; Lee/40, ATCC, Cat# VR-1535). Samples were prepared at low and moderate positive concentrations 
(2X LoD and 5X LoD, respectively) in pooled SARS-CoV-2/influenza A/influenza B negative clinical NP swab 
matrix (Tabel 38). For each data point, all panel members were extracted five times using the QIAGEN 
QIAamp Viral RNA Mini Kit (140 µL sample input and 60 µL elution volume). Nucleic acid from these 
extractions was tested on the CFX Opus 96 and the CFX96 Touch with the Bio-Rad Reliance SARS-CoV-
2/FluA/FluB RT-PCR Assay Kit. One operator tested the 5-member reproducibility panel with 5 replicates 
on 3 different days on 2 different instruments for a total of 300 replicates (5 panel members x 5 replicates 
x 2 lots x 3 days x 2 instruments). 

The expected result for the negative panel member was “Not Detected,” while the expected result for the 
low and moderate positive panel members was “Detected” for the respective target. The data demonstrate 
an acceptable level of precision for the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit. Detailed 
results are summarized in Table 39 and Table 40 for Influenza A and Influenza B, respectively. The Bio-Rad 
Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit exhibited the expected hit rates for all targets. 
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Table 38. Concentration of Panel Members and Correlation to LoD Per Instrument 

Panel Member Concentration 
(copies/mL) 

Correlation to Live Influenza LoD 
CFX Opus 96 CFX96 Touch 

Influenza A Low + 2004 2X 2X 
Influenza A Med + 5010 5X 5X 
Influenza B Low + 1724 2X 2X 
Influenza B Med + 4310 5X 5X 

Negative N/A N/A N/A 
N/A; Negative, no detectable Cq value 
 

Table 39. Influenza A Precision – Summary of Detection Rates 

Panel 
Member 

CFX Opus 96  CFX96 Touch Total 
Agreement 
w/Expected 

Result 

Mean
Cq 

Cq 
%CV 

Agreement 
w/Expected 

Result 

Mean 
Cq 

Cq 
%CV 

Agreement 
w/Expected 

Result 

Cq 
[95% CI] 

Negative 30/30 N/A N/A 30/30 N/A N/A 60/60 N/A 
FluA mod+ 30/30 33.81 0.72 30/30 34.00 0.84 60/60 [93.98, 100] 
FluA low+ 30/30 35.79 1.75 30/30 36.06 1.32 60/60 [93.98, 100] 
FluB mod+ 30/30 N/A N/A 30/30 N/A N/A 60/60 N/A 
FluB low+ 30/30 N/A N/A 30/30 N/A N/A 60/60 N/A 

Total 
Agreement 150/150 150/150 300/300 

N/A; Negative, no detectable Cq value  
 
Table 40. Influenza B Precision – Summary of Detection Rates 

Panel 
Member 

CFX Opus 96 CFX96 Touch Total 
Agreement 
w/Expected 

Result 

Mean 
Cq 

Cq  
%CV 

Agreement 
w/Expected 

Result 

Mean 
Cq 

Cq 
%CV 

Agreement 
w/Expected 

Result 

Cq 
[95% CI] 

Negative 30/30 N/A N/A 30/30 N/A N/A 60/60 N/A 
FluA mod+ 30/30 N/A N/A 30/30 N/A N/A 60/60 N/A 
FluA low+ 30/30 N/A N/A 30/30 N/A N/A 60/60 N/A 
FluB mod+ 30/30 35.91 1.60 30/30 35.64 1.51 60/60 [93.98, 100] 
FluB low+ 30/30 37.13 1.55 30/30 37.00 1.45 60/60 [93.98, 100] 

Total 
Agreement 150/150 150/150 300/300 

N/A; Negative, no detectable Cq value 

The variance component analysis for each level and target is summarized in Table 41 and Table 42. 
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Table 41. Precision/Repeatability Study (Within-Run) - Overall Mean, Standard Deviations (SD), and 
Coefficients of Variation (CV%) for Target Cq Values  

Run 
FluA Mod + FluA Low + FluB Mod+ FluB Low+ Negative 

Mean 
Cq SD %CV Mean 

Cq SD %CV Mean 
Cq SD %CV Mean 

Cq SD %CV Mean 
Cq SD %CV 

CFX Opus 96 
Run 1 33.71 0.25 0.74 35.84 0.38 1.06 36.20 0.46 1.27 37.27 0.71 1.92 N/A N/A N/A 
Run 2 33.79 0.21 0.63 35.24 0.44 1.26 35.40 0.35 0.98 37.02 0.55 1.48 N/A N/A N/A 
Run 3 33.97 0.24 0.70 36.30 0.54 1.48 36.12 0.22 0.60 37.10 0.47 1.26 N/A N/A N/A 

CFX96 Touch 
Run 1 33.80 0.16 0.47 35.84 0.36 1.00 35.53 0.36 1.02 36.83 0.64 1.75 N/A N/A N/A 
Run 2 33.97 0.29 0.85 36.08 0.44 1.21 35.56 0.54 1.53 37.11 0.50 1.34 N/A N/A N/A 
Run 3 34.23 0.23 0.67 36.25 0.56 1.53 35.82 0.44 1.22 37.07 0.47 1.25 N/A N/A N/A 

N/A; Negative, no detectable Cq value 

Table 42. Precision/Repeatability Study (Lot-to-Lot, Day-to-Day, and Run-to-Run) - Overall Mean, 
Standard Deviations (SD), and Coefficients of Variation (CV%) for Target Cq Values 

Target Panel 
Member 

Detection 
Rate 

Mean 
Cq 

Lot-to-Lot Day-to-Day Run-to-Run 
SD CV% SD CV% SD CV% 

CFX Opus 96 

FluA 
Mod + 100% 33.81 0.24 0.72 0.24 0.72 0.24 0.72 
Low + 100% 35.79 0.63 1.75 0.63 1.75 0.63 1.75 

Negative 100% N/A N/A N/A N/A N/A N/A N/A 

FluB 
Mod + 100% 35.91 0.50 1.39 0.57 1.60 0.57 1.60 
Low + 100% 37.13 0.57 1.55 0.57 1.55 0.57 1.55 

Negative 100% N/A N/A N/A N/A N/A N/A N/A 
CFX96 Touch 

FluA 
Mod + 100% 34.00 0.29 0.84 0.29 0.84 0.29 0.84 
Low + 100% 36.06 0.48 1.32 0.48 1.32 0.48 1.32 

Negative 100% N/A N/A N/A N/A N/A N/A N/A 

FluB 
Mod + 100% 35.64 0.46 1.28 0.54 1.51 0.54 1.51 
Low + 100% 37.00 0.54 1.45 0.54 1.45 0.54 1.45 

Negative 100% N/A N/A N/A N/A N/A N/A N/A 
N/A; Negative, no detectable Cq value 

Fresh vs Frozen 
The Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit was tested by comparing performance of 
fresh specimens compared to the same specimens after repeated freeze/thaw cycles. One influenza A 
strain (Influenza A H3N2 (Kansas/14/17), ZeptoMetrix, Cat# 0810586CF), one influenza B strain (Influenza 
B (Colorado/06/17), ZeptoMetrix, Cat# 0810573CF), and one SARS-CoV-2 strain (2019-nCoV/USA-
WA1/2020, ATCC VR-1986HK) were individually spiked into negative clinical NP swab matrix received 
within 72 hours of sample collection (shipped unfrozen with cold packs), at two different viral 
concentrations reflecting 2x and 5x LoD for each virus, as described in Table 43. A set of negative clinical 
samples was also tested.  

For each viral strain, 20 fresh samples (10 per concentration per virus) were extracted using the QIAGEN 
QIAamp Viral RNA Mini Kit (140 µL sample input and 60 µL elution volume), and the nucleic acid from these 
extractions was tested with the Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit on one CFX Opus 
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96 instrument.  A second set of 20 samples (10 per concentration per virus) underwent 3 freeze/thaw 
cycles (frozen at -80°C then thawed at room temperature), extracted, and tested with the same kit and 
instrument. All controls performed as expected. Agreement in detection between fresh and frozen samples 
was 100% for the two concentrations for influenza A, influenza B, and SARS-CoV-2, as well as for the 
negative samples for all freeze/thaw cycles. There was no evidence of a trend in Cq values that would 
indicate a difference in performance for any of the analytes that were present in contrived samples that 
underwent up to three sequential freeze/thaw cyclesResults are shown in Table 44. 

Table 43. Contemporary Viral Strains and Concentrations Tested in the Fresh vs. Frozen Study 
Virus Strain LoD 2X LoD 5X LoD 

SARS-CoV-2 2019-nCoV/USA-WA1/2020 250 copies/mL 500 copies/mL 1250 copies/mL 
Influenza A H3N2 (Kansas/14/17) 589 copies/mL 1178 copies/mL 2945 copies/mL 
Influenza B Colorado/06/2017 593 copies/mL 1186 copies/mL 2965 copies/mL 

 
Table 44. Fresh versus Frozen Study Results 

Sample Type 
Fresh Freeze/Thaw Cycle 1 Freeze/Thaw Cycle 2 Freeze/Thaw Cycle 3 Total 

Positivity SC2 FluA FluB SC2 FluA FluB SC2 FluA FluB SC2 FluA FluB 

FluA 
2X LoD 

Mean Cq N/A 36.91 N/A N/A 36.70 N/A N/A 35.93 N/A N/A 35.83 N/A 
40/40 

StdDev N/A 0.90 N/A N/A 0.39 N/A N/A 0.37 N/A N/A 0.51 N/A 

FluA 
5X LoD 

Mean Cq N/A 35.14 N/A N/A 35.33 N/A N/A 34.50 N/A N/A 34.69 N/A 
40/40 

StdDev N/A 0.17 N/A N/A 0.43 N/A N/A 0.25 N/A N/A 0.15 N/A 
FluB 

2X LoD 
Mean Cq N/A N/A 36.78 N/A N/A 37.08 N/A N/A 37.02 N/A N/A 36.20 

40/40 
StdDev N/A N/A 0.42 N/A N/A 0.69 N/A N/A 0.68 N/A N/A 0.52 

FluB 
5X LoD 

Mean Cq N/A N/A 35.52 N/A N/A 35.71 N/A N/A 35.08 N/A N/A 35.36 
40/40 

StdDev N/A N/A 0.73 N/A N/A 0.43 N/A N/A 0.72 N/A N/A 0.38 
SC2 

2X LoD 
Mean Cq 36.13 N/A N/A 37.06 N/A N/A 36.31 N/A N/A 36.57 N/A N/A 

40/40 
StdDev 0.43 N/A N/A 0.45 N/A N/A 0.59 N/A N/A 0.60 N/A N/A 

SC2 
5X LoD 

Mean Cq 34.72 N/A N/A 34.35 N/A N/A 35.14 N/A N/A 35.05 N/A N/A 
40/40 

StdDev 0.39 N/A N/A 0.25 N/A N/A 0.29 N/A N/A 0.27 N/A N/A 

Negative 
Mean Cq N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A 

0/40 
StdDev N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A 

N/A; Negative, no detectable Cq value 

Retrospective Clinical Evaluation 
The performance of Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit with nasopharyngeal swab 
clinical samples was evaluated at an internal Bio-Rad site using clinical remnant individual samples 
collected from patients with signs and symptoms of an upper respiratory infection as follows:  

● 32 influenza A and B negative samples as determined using a 510(k) cleared molecular assay 
(cleared within the last 5 years), which were confirmed to also be negative for SARS-CoV-2 with 
the Bio-Rad SARS-CoV-2 ddPCR Kit (EUA authorized molecular assay).  

● 69 influenza A positive samples confirmed using a 510(k) cleared multi-analyte molecular assay  
● 43 influenza B positive samples confirmed using a 510(k) cleared multi-analyte molecular assay 
● 42 SARS-CoV-2 positive samples confirmed using EUA authorized molecular assays  
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The samples were collected by qualified personnel according to the package insert of the collection device 
and stored frozen at -80°C. The positive specimens represent a wide range of viral load and included low 
positive samples. No Cq/Ct values were available for these samples so these were all tested internally using 
an acceptable EUA RT-PCR assay to confirm that a representative range of clinical samples was tested and 
to serve as the adjudicator test in the event of a discrepancy between Bio-Rad Reliance SARS-CoV-
2/FluA/FluB RT-PCR Assay Kit result and the result from the Influenza A/B (IVD) or SARS-CoV-2 (EUA) test 
for a given sample.   

Nucleic acid was purified from the 186 clinical samples using the QIAGEN QIAamp Viral RNA Mini kit using 
a sample volume of 140 μL and an elution volume of 60 μL. The samples were blinded, and assessed with 
Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit using the Bio-Rad CFX Opus 96 instrument. The 
Bio-Rad CFX Opus 96 is considered representative of all the instruments validated for use with the Bio-Rad 
Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit, as demonstrated during the LoD study.  

Of the 186 unique clinical samples, there were 154 positive results (including both concordant and 
discordant positives) and 32 negative results. The 154 positive results were from 154 unique patient 
samples and the 208 concordant negatives were from 144 total sample results. The majority of the results 
of the clinical evaluation show concordant results with the comparator tests. All controls performed as 
expected. Data are presented in Table 45.  

Table 45. Clinical Performance - Comparison of Bio-Rad Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay 
Kit with Other FDA Cleared/Authorized Comparator Methods 

Analyte Number of 
Samples 

Test Results Agreement Statistics 
Concordant 

Positive 
(N) 

Discordant 
Positive 

(N) 

Concordant 
Negative 

(N) 

Discordant 
Negative 

(N) 

Agreement 
Parameter 

Percent 
Agreement 

(%) 

95% CI 
(LCL, UCL)* 

Influenza A 144 69 0 75 0 PPA 100% 94.7%, 100% 
NPA 100% 95.1%, 100% 

Influenza B 144 43 0 101 0 PPA 100% 91.8%, 100% 
NPA 100% 96.3%, 100% 

SARS-CoV-2 74 41 1a 32 0 PPA 97.6% 87.7%, 99.6% 
NPA 100% 89.3%, 100% 

PPA = Positive Percent Agreement, NPA = Negative Percent Agreement 
CI = confidence interval; LCL = Lower confidence Limit; UCL = Upper confidence Limit 
*Confidence interval is calculated using Wilson's Score method 
a Discordant analysis was completed using an EUA-RT-PCR assay and was negative for SARS-CoV-2 
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Appendix A:  Additional Label  
For CFX96 Touch and CFX Opus 96 Real-Time PCR Systems 

Please print and place this label on the front panel of the instrument.  If the instruments include labeling 
indicating “For Research Use Only”, please cover with the below “Emergency Use Only” labeling. The 
instrument should retain this labeling throughout the EUA use of the Bio-Rad Reliance SARS-CoV-
2/FluA/FluB RT-PCR Assay Kit. 
 
 
 

Emergency Use Only 
This instrument is authorized for use with Bio-Rad 
Reliance SARS-CoV-2/FluA/FluB RT-PCR Assay Kit 



 

IVD, Rx-only, for use under EUA only  
Download instruction for use at  
 
bio-rad.com/SARS-CoV-2FluAFluB-IVD 
 
Please contact Bio-Rad Laboratories (1-800-424-6723, option 2) if you require a printed copy 
free of charge 

• This product has not been FDA cleared or approved, but has been authorized for emergency 
use by FDA under an EUA for use in laboratories certified under the Clinical Laboratory 
Improvement Amendments of 1988 (CLIA), 42 U.S.C.§263a, that meet requirements to perform 
high complexity tests;  

• This product has been authorized only for the simultaneous qualitative detection and 
differentiation of nucleic acids from SARS-CoV-2, influenza A virus, and influenza B virus and 
not for any other viruses or pathogens; and 

• The emergency use of this product is only authorized for the duration of the declaration that 
circumstances exist justifying the authorization of emergency use of in vitro diagnostics for 
detection and/or diagnosis of COVID-19 under Section 564(b)(1)of the Act, 21 U.S.C. § 360bbb-
3 (b)(1), unless the declaration is terminated, or authorization is revoked sooner.  
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